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Important note:
The basic package contains at least one Gigabit Ethernet interface, which includes a vari-
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Thus, depending on the scope of function supplied, individual menu options may be hid-
den.
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1 Introduction
1  Introduction

ARGUS 300: the universal broadband tester 
The new ARGUS 300 all-in-one tester delivers improved performance for testing 
broadband interfaces. The high-quality multifunction tester is ideally equipped for the 
Expansion of future networks. 

Modern design and new housing concept 
Its robust design combines the requirements for a compact hand-held meter in daily field 
use with the performance of a high-end tester. The ARGUS tester with touch-screen 
display enables intuitive navigation of the familiar ARGUS menu structure. Thanks to the 
use of numerous graphical elements, the redesigned GUI makes this sophisticated 
multifunction tester as easy to use as a smartphone. A new, innovative internal help 
function supports rapid, reliable interpretation of test results. 

All necessary broadband interfaces 
The ARGUS 300 reliably tests all broadband interfaces, e.g. GPON, FTTx (PtP) and G.fast 
(106 + 212 MHz), super vectoring, bonding, ADSL, VDSL and SHDSL accesses, in the 
uncompromising quality you have come to expect. It is also equipped with a wide range of 
further interfaces and test functions, such as 2.5 GB Ethernet, WLAN, Copper, TDR, RFL, 
triple Play and many more. An extremely high-performance hardware is planned 
specifically for tests in the Gigabit Ethernet range (up to 10 GigE). 

Additional features 
The integrated WIFI interface enables the ARGUS 300 to communicate with its enviroment 
directly – a PC link is no longer required. 
Once integrated in your job management system, the ARGUS 300 marks the advent of a 
new generation of broadband testing.
6 ARGUS 300



1 Introduction
Overview of key ARGUS functions:
Ethernet interfaces
- Ethernet tests with up to 10 Gbit/s (loop, traffic generator, RFC2544, Y.1564)
- 10/100/1000 Base-T
- LAN1 additionally with 2.5 GBase-T (2.5GbE), 2500 BASE-T (IEEE 802.3bz, 

NBase-T)
- LAN2 additionally with 5/10 GBASE-T (5/10 GbE), 5000/10000 BASE-T, 

(MGBASE-T) (IEEE 802.3ak, IEEE 802.3an)
- SFP1: full SFP interface (FTTx, PtP)

- 100 Base-FX/LX (IEEE 802.3 Clause 26/58)
- 1000 Base-BX/LX/SX/ZX Active Ethernet (IEEE 802.3 Clause 38 bzw. 

802.3z)
- 2.5 GBase-X (2.5GigE/2.5GbE)

- SFP2: full SFP+ interface (FTTx, PtP)
- 10 GBASE-X (10GbE/10GE), 10000 BASE-X (IEEE 802.3ae)

Fiber interfaces
- ARGUS Optical Power Meter (via SFP)
- Fiber Inspection Tool (via USB)
- Optical Time Domain Reflectometer (OTDR)
- Optical Fault Finder (via SFP)
- GPON and PON Installation Test
WLAN interface
- WLAN Access Point Mode
- WLAN AP Scan
- WLAN Client
- WLAN Spectrum Analysis
- WLAN Management
G.fast and xDSL interfaces (ADSL, ADSL2, ADSL2+, VDSL2, VDSL2 profile 35b, 
SHDSL, G.fast)
- Synchronisation with DSLAM (xTU-C) and determination of all relevant 

connection parameters and error counters
- Bridge, router and terminal-device modes, via IPv4 and IPv6
- SHDSL-DSLAM simulation (STU-C) 
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1 Introduction
IP tests via Ethernet, GPON, FTTH, xDSL and WLAN
- IP tests

- Ping and traceroute tests (BRAS information, PPP trace, VLAN), via IPv4 and 
IPv6

- Download tests for determining throughput rate (HTTP download, FTP up/
download

- Speed test via iperf, Speedtest by Ookla, ARGUS Real Speed according to 
RFC 6349

- FTP server test, up/download from ARGUS to ARGUS
- Concurrent testing of multiple services (VoIP, IPTV, data)

- VoIP tests
- VoIP terminal device simulation, including acoustics (var. codecs), via IPv4 and 

IPv6
- OK/FAIL assessment of VoIP speech quality (QoS) according to: 

- MOSCQE (ITU-T P.800), E-model (ITU-T G.107)

- IPTV tests
- Stream request (STB mode), IPTV channel scan, IPTV passive

- OK/FAIL assessment and display of quality parameters
- Moving picture mode with live picture

ISDN functions
- BRI S/T interface according to ITU-T I.430 in TE mode
- PRI/E1 interface according to ITU-T I.431 and ITU-T G.703 in TE mode

POTS functions
- Fully functional integrated analogue handset (POTS)
- With DTMF and CLIP display, pulse dialling

- High-ohm 2-wire monitor with voltage measurement

Documentation and analysis
- Documentation of data through automatic access tests in access acceptance logs, 

in device and on PC in HTML format.
- Transmission of results to smart phone using QR code.

- Free firmware updates via the cloud or using the update tool.
- WLAN extension for transferring measurements to systems for electronic job pro-

cessing, access point mode (browsers, download) or remote control using smart 
phones.
8 ARGUS 300



1 Introduction
Note: 
You can download the latest manuals at http://www.argus.info/service/downloads 
or simply contact one of our service representatives:

intec Gesellschaft für Informationstechnik mbH
Rahmedestr. 90

D-58507 Lüdenscheid
Tel.: +49 (0) 2351 / 9070-0

Fax: +49 (0) 2351 / 9070-70
www.argus.info/en

support@argus.info
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2 Safety information
2 Safety information

The ARGUS may only be operated using the accessories supplied with the device. The use 
of other accessories can result in faulty measurements or even damage to ARGUS and the 
connected equipment. Only use the ARGUS according to the instructions contained in this 
accompanying document. Use in any other manner can cause harm to persons or destroy 
your ARGUS.

- Before connecting your ARGUS to a local access, ensure that no hazardous 
voltages/currents, or voltages/currents for which the ARGUS or its 
accessories are not designed, are present. Also keep in mind that the voltage 
can change over the time that the device is connected.

- Use the ARGUS only according to its intended purpose (standard) at all 
interfaces and accesses.

- Voltages over 50 V AC and 120 V DC can cause death.
- Never conduct measurements without the battery pack!
- The ARGUS is not waterproof. Therefore, protect the ARGUS against water 

penetration.
- Before replacing the battery pack, remove the power supply and all 

measuring leads and switch off your ARGUS instrument. 
ATTENTION: Never remove the battery pack during operation.

- Remove the power adapter from the mains socket as soon as the ARGUS is 
switched off or no longer in use (e.g. after charging the battery pack)!

- The ARGUS may only be used by trained personnel.
- The ARGUS may only be operated using the power adapter supplied with the 

device. 
- Only manufacturer-approved USB devices without mains connection may be 

connected to the USB host interfaces (USB-A). The instrument can be 
connected to a PC as a mass storage device.

- If external USB devices are used on the USB-host interface (USB-A), no 
warranty is assumed for occurrences outside the mechanical wear of normal 
plug-in.

- Only use the SFP slots for SFP types explicitly approved by intec GmbH. 
Never insert other objects or SFP modules into the SFP slots.

- When the SFP slots are not in use, always make sure that they are sealed 
using the supplied protective covers.

- When using the SFP slots and SFP modules, always be sure to observe 
normal cleanliness.

- When using SFP modules, always be sure to observe the module 
manufacturer's safety information and use them only for their intended 
purpose.
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2 Safety information
- The SFP modules typically approved for ARGUS are generally class 1 laser 
devices. 
Normally, the use of class-1 laser products does not require any special 
protection measures. 
However, for your own safety please note the following: 
- Always cover the ends of the optical fibres and the SFP module when the 
connection is interrupted. 
- Always avoid direct eye contact with the emitted laser light. Vision aids 
and long exposure times can make even low light doses extremely 
dangerous. 
- The equipment may only be used by trained personnel.

- The electromagnetic compatibility (EMC) was tested according to the 
regulations specified in our declaration of conformity. 
Your ARGUS instrument is a class A device, and can cause radio interference 
in residential areas. In this case, the user may be required to implement 
appropriate measures.

- The active charging of the battery pack (charging the battery) and automatic 
charging (on by default) may only be carried out in a temperature range of 0 
°C to +40 °C.

- The device may not be used during thunderstorms.
- If the ARGUS is operated under extreme conditions, it can be set to energy-

saving mode to protect the device and the user; this can interrupt the running 
test and drop the connection. 
To ensure dependable extended operation of the ARGUS, always make sure 
that it is optimally protected against high temperatures.

- The device may not be opened.
- Please observe the following safety and transport information when using the 

lithium-ion battery pack.
- Before starting a test or synchronising on an interface, determine how you 

want to supply power to the ARGUS (battery pack or power adapter). 
The car adapter is only intended for charging the device. When the ARGUS is 
connected to this adapter, you should not run any tests or synchronise on a 
DSL interface.

- The ARGUS contains extremely sensitive electronic components. Depending 
on the operating mode selected, an electronic discharge from the user can, in 
rare cases, result in impairment of device function. The user may need to 
restart the impaired test or function.
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2 Safety information
Return and environmentally compatible disposal
Current environmental law restricts the use of certain hazardous substances in electrical 
and electronic devices, in particular the concentration or use of lead (Pb), cadmium (Cd), 
mercury (Hg), hexavalent chromium [Cr(VI)], polybrominated biphenyls (PBB) and 
polybrominated diphenyl ethers (PBDE). 
We hereby confirm that, according to the assurances, marking and documentation of our 
suppliers, ARGUS brand measuring products do not contain any substances in 
concentrations, compounds or applications whose marketing is prohibited according to the 
valid provisions of the RoHS Directive 2011/65/EU of the European Parliament and Council 
dated 8 June 2011. 
Our registration number issued by the EAR is: WEEE REG. no. DE 92829367.

Since October 2005, we have been marking all our measuring devices with this symbol, in 
compliance with WEEE 2002/96/EC and the corresponding German statute ElektroG: 

 ( ) (DIN EN 50419). 

In other words, the ARGUS and its accessories may not be disposed of as household 
waste. Please consult with our Service department with respect to the return of old devices. 
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2 Safety information
2.1 Safety and transport information for the battery pack

Transport
The battery pack has been tested according to the UN directive (ST/SG/AC.10/11/Rev. 4, 
part III., subchapter 38.3). Protective functions have been implemented to guard against 
short-circuit, destruction and dangerous reverse currents. The quantity of lithium contained 
in the battery pack is below current thresholds, and thus not subject to international regula-
tions governing hazardous materials either as an individual part or mounted in the ARGUS. 
When transporting multiple battery packs, however, you may also need to observe these 
regulations. Further information is available on request. 
 

Failure to observe the following danger and warning information can impair 
the protective functions of the battery pack. This can cause extremely high 
voltages and currents which can in turn result in abnormal chemical 
reactions, acid leaks, overheating, smoke, explosion and/or fire.  
Additionally, failure to observe this information can negatively impact both 
the performance capacity and the performance duration.
 

Hazard information and warnings
1. Do not disassemble or short-circuit the battery pack.
2. Do not throw the battery pack into fire or overheat it (> 60 °C).
3. The battery pack must not become wet or damp.
4. Active charging of the battery pack and automatic charging (on by default) may 

only be carried out in a temperature range of 0 °C to +40 °C.
5. To maximise battery life, do not store the battery long-term at temperatures above 

+50 °C.
6. The battery pack may only be charged using the corresponding ARGUS device.
7. Do not puncture the battery pack with a sharp object.
8. Do not throw the battery pack or expose it to shocks.
9. Do not use battery packs that have become damaged or deformed.
10. The battery pack contacts have a specific polarity (positive and negative); do not 

insert them in the ARGUS with reverse polarity.
11. Only connect the battery pack to the corresponding ARGUS in the intended 

manner.
12. The battery pack may not be directly connected to electrical outputs such as 

power adapters, car adapters etc.
13. Only use the battery pack with ARGUS.
14. Do not attach, transport or store the battery pack together with metallic objects.
15. Do not expose the battery pack to electrostatic charges.
16. The battery pack may not be charged or discharged together with primary 

batteries or other battery packs.
ARGUS 300 13



2 Safety information
17. If the battery pack fails to charge by the end of the charging time, it can no longer 
be recharged.

18. Do not expose the battery pack to excessive pressure.
19. If the battery pack emits odours or heat, becomes discoloured or deformed or 

otherwise appears different from normal during operation, charging or storage, 
immediately remove the battery pack from the device and never use it again.

20. 20. In the event that acid leaks and comes in contact with eyes or skin, wash 
immediately with clean water. Do not rub. In both cases, seek medical attention 
immediately. Otherwise, permanent injury may occur.

21. Keep the battery pack away from children.
22. Read this manual and the corresponding safety information carefully before using 

the battery pack.
23. If odours, rust or other abnormalities are detected before the first use, contact 

intec GmbH to clarify the next steps.
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2 Safety information
Further details 
Battery compartment 
The battery pack compartment is on the rear of the device. Generally, you do not need to 
replace the battery pack. 
If this should become necessary, unscrew the two screws of the battery compartment 
cover and remove the cover. The battery pack inside the compartment can easily be 
detached from the plug connector and removed. The plug is reverse polarity protected, so 
that you can insert a new battery pack with no difficulties. 
Use only the battery pack supplied with the device. 

First-time operation 
Connect the switched-off ARGUS to the supplied plug-in power supply. The ARGUS will 

automatically switch on when the power supply is plugged in. After pressing the  key, 

select the option “Battery (status, charging)”. The option “Status” displays further 
information, such as voltage and current level. 
The Accesses display can vary depending on the configuration. You must first change the 
battery pack supplied with the device completely before full capacity is reached. 

Automatic charging 
Select this option to toggle the automatic charging functionality on or off. You can also do 
this in the ARGUS Manager, which you can access by swiping down or pressing the 
power key. Here, automatic charging can be toggled on and off. The ARGUS charges the 
battery automatically in the background when the power adapter is connected as soon as 
the battery status falls below a threshold value (battery symbol in display). When the 
ARGUS is disconnected from the power adapter before that battery is completely 
charged, the ARGUS does not automatically continue charging when it is subsequently 
reconnected because the charge is no longer below the threshold. 

Power-saving mode 
In battery mode, the ARGUS automatically switches off after five minutes of no activity 
(interval adjustable). The ARGUS does not switch off during a test (e.g. loop) or in trace 
mode. The device can alternatively be operated using the supplied external adapter. 
When the adapter is connected, power supply via the battery is automatically switched off. 
The ARGUS must always be operated with the battery, regardless of the power supply. 
This ensures e.g. uninterrupted operation of the real-time clock. Remove the power 
adapter from the mains socket as soon as the ARGUS is switched off or no longer in use 
(e.g. after charging the battery pack)! 
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2 Safety information
Handling the battery pack 
Power down the ARGUS and disconnect the power adapter. Then unscrew the screws 
holding the battery compartment cover. The battery pack inside the compartment can 
easily be detached from the plug connector and removed. The plug is reverse polarity 
protected, so that you can insert a new battery pack with no difficulties. 
Use only the battery pack supplied with the device. 
Attaching any other power supply to the device contacts will damage your ARGUS 
instrument. 
- Only charge the supplied battery pack in the ARGUS. 
- Do not use the ARGUS battery pack in other devices. 
- Active charging of the battery pack and automatic charging (on by default) may only 
be carried out in a temperature range of 0 °C to +40 °C. 
- The lithium ion battery pack should be stored with a charge of 40 to 60 %. When 
storing the device for longer periods, you should refresh this charge level every six 
months. To prevent full discharge, remove the battery pack from the device for long-term 
storage. To maximise battery life, do not store the battery long-term at temperatures 
above +50 °C. 

Battery indicator 
The ARGUS indicates the current state of the battery graphically in the display when no 
power adapter is connected. A battery symbol flashes in the display when it is down to a 
power reserve of approx. 8 minutes (depending on the operating mode). Tone errors, and 
in extreme cases malfunctions, can occur in this period. Connect the power adapter. The 
ARGUS can recharge the battery completely when the power adapter is connected. The 
ARGUS power pack does not require manual discharge. A complete charging process 
can take up to approx. 6 hours. 
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3 General technical data
3 General technical data

Device specifications:

Dimensions/weight Inputs/outputs

Height: 300 mm  
Width: 128 mm  
Depth: 94 mm 
Weight: < 2 kg 
(4.41 lbs) 
(incl. battery pack) 

- 1x RJ-45 und 1x RJ-11 (Line) for xDSL, G.fast, BRI S/T 
and U/R/C 
- 1x RJ-45 for SHDSL 
- 1x RJ-45 for PRI 
- 2x Ethernet: 1x 10/100/1000/2500 base-T and 1x RJ-
45 Test port (LAN cabling) 
- 1x RJ-45/Ethernet 10000 base-T/10 GigE 
- 2x SFP ports: 1x 100 base-FX/LX, 1000 base-SX/LX/
ZX/BX and 1x SFP+ for 10 GBase-T 
- 1x SC/APC for OTDR 
- 5 x 4 mm banana sockets, contact-protected for cable 
multimeter (DMM) 
- 1x USB client interfaces, type micro B, for accessing 
USB mass storage 
- 2X USB host interfaces, type A, for external devices 
- WLAN IEEE802.11a/b/g/n 
- 1x 12V DC socket

Control panel

28 keys 
4 softkeys 
4 cursor keys 
Touch display

Display Temperature range

TFT colour display, 
Touchscreen, illuminated 
800 x 400 Pixel

Temperature range for charging battery pack: 0 °C (+32 °F) 
to +40 °C (+104 °F) 
Max. Operating temperature (endurance tests): 0 °C  
(+32 °F) to +40 °C (+104 °F) 
Max. Operating temperature (battery mode): 0 °C (+32 °F) 
to +40 °C (+104 °F) 
Operating temperature (with power/car adapter): 0 °C  
(+32 °F) to +40 °C (+104 °F) 
Storage temperature: -20 °C (-4 °F) up to +60 °C (+140 °F) 
Humidity: up to 95 % rel. humidity, non-condensing
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3 General technical data
Power supply

Lithium ion battery pack with 7.2 V rated voltage (always 
observe the safety instructions!) 
or 12 V/1.5 A ARGUS power adapter

Miscellaneous

ARGUS user safety tested according to EN62368-1, RoHS 
conformity according to the WEEE Directive.
The electromagnetic compatibility (EMC) was tested 
according to the regulations specified in our declaration of 
conformity.
CE mark
The ARGUS 300 fulfils the EC directives for the CE mark. 
We will be happy to provide a detailed declaration of confor-
mity on request.
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3 General technical data
Supported Standards:

ADSL (line): 
ITU-T G.992.1, Annex A (ADSL) 
ITU-T G.992.2, Annex A (G.lite) 
ITU-T G.992.3, Annex A (ADSL2) 
ITU-T G.992.5, Annex A (ADSL2+) 
ITU-T G.992.1, Annex B (ADSL) 
ITU-T G.992.5, Annex B (ADSL2+) 
ITU-T G.992.5, Annex J (ADSL2+)

G.fast (line): 
ITU-T G.9700/9701 (profile 106a) 
ITU-T G.9700/9701 (profile 212a)  

ISDN (BRI/PRI/E1):
ITU-T I.430
ITU-T I.431
ITU-T G.703

GPON (SFP): 
ITU-T G.984 
PON Installation Test

OTDR: 
SC/APC (8°) IEC 61754-4 

Fiber Inspection (USB-A): 
IEC 61300-3-35

WLAN: 
IEEE 802.11a/b/g/n

VDSL (line): 
ITU-T G.993.2 (VDSL2) 
ITU-T G.993.5, G.vector (vectoring) 
ITU-T G.998.2, G.bond (bonding) 
ITU-T G.993.2, Annex Q (super vectoring)
Profiles:
8a, 8b, 8c, 8d, 12a, 12b, 17a, 30a, 35b 
ITU-T G.998.4 (G.INP, retransmission)

Ethernet (LAN/SFP): 
IEEE 802.3   
- 10 base-T  
- 100 base-T
- 1000 base-T 
- 10 Gbase-T 
- SFP (MSA)
Autonegotiation
auto-MDI(X)

SHDSL (line): 
ITU-T G.991.2, Annex A (G.SHDSL) 
ITU-T G.991.2, Annex B (G.SHDSL) 
ITU-T G.991.2, Annex F (G.SHDSL.bis) 
ITU-T G.991.2, Annex G (G.SHDSL.bis) 
ETSI TS 101 524 V 1.2.1 (ETSI SDSL) 
ETSI TS 101 524 V 1.2.2 (E.SDSL.bis) 
IEEE 802.3.ah (EFM) 
ITU-T G.994.1 (G.hs)

ITU-T G.992.3, Annex L  
 (RE-ADSL2 via analogue) 
ITU-T G.992.3, Annex L  
 (RE-narrow PSD ADSL2 via analogue) 
ITU-T G.992.3, Annex M (ADSL2) 
ITU-T G.992.5, Annex M (ADSL2+)

Dielectric strength: 
 
 

Line:
DC: max. +200 V
AC: max. +100 Vpp (copper tests only)
DC: max. +200 V (xDSL) 

Banana sockets:
DC: max. +200 V 
AC: max. +200 V
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4 Quick-start

Cursor keys
Enter key

 Telephony: answer/hang up
Power

Number pad

            Back key

Loudspeaker

Power key

- 
- 
- 
 
 
- 

-

 
-

Switches on the ARGUS 
Restart after power down 
Switches on display illumination (also possible with any other key). In 
battery mode, the display illumination switches off automatically after an 
interval that can be set in ARGUS 
Opens the ARGUS Manager from any point in the menu (press briefly). 
Return from the ARGUS Manager to the original menu. 
Switches off the ARGUS (key must be held down): after an adjustable 
interval (e.g. after 10 minutes), the ARGUS automatically shuts down in 
battery mode (see page 197). 
Emergency switch off if pressed for more than 10 seconds

Enter key

- 
- 
- 
-

Opens menu 
Switches to next display 
Starts/opens test 
Accepts setting

Touch display

LEDs

Softkeys

Wheel key Menu key

Level key
Shift key

 guide
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4 Quick-start guide
Back key

- 
 
- 
-

Switches the ARGUS back to the previous display without saving current 
entries, e.g. changes in a configuration parameter 
Exits graphic displays 
After power-up: opens the main menu

Cursor keys

- 
 
- 
 
- 
- 
- 
-

Browse display lines page by page (vertical cursor keys) Cursor 
movement within a display line (horizontal cursor keys)  
In the lists of options or statistics, you can use the horizontal cursor keys to 
browse by pages 
Select a menu, a function or a test  
Define lead types for TDR 
Move display cursor in graphic displays 
Select functions in graphic status screen

Telephony

Analogue

- Answers and hangs up 

G.fast, xDSL (access mode xTU-R, xTU-R router), WLAN, GPON and 
Ethernet 

- 
-

Starts VoIP telephony 
Accepts an incoming VoIP call

Level key

- 
- 
-

G.fast and xDSL accesses: displays results 
Ethernet: opens results 
Start/stop function for realtime analyses (line scope/TDR)

Number pad

- 
- 
 
 
 

Entry of numerals 0 through 9, letters and special characters 
Direct function call, depending on the selected access (hot key), e.g. 
page 204
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4 Quick-start guide
The ARGUS can be controlled using the four cursor keys, the Enter key , the 

Back key , the level key  and the four softkeys. The bottom line of the display 

shows the current assignments of the four softkeys. In the following pages of this manual, 
only the respective currently valid softkey function is displayed in angle brackets < > , e.g. 

<Access>. The softkey  has the same function as the Enter key  . 

The ARGUS 300 can also be operated using the touchscreen.
You can access the next menu and enter and confirm settings by tapping the corres-
ponding screen location. The softkeys displayed at the bottom can also be actuated using 
the touchscreen. Additionally, you can scroll up and down by swiping and zoom in and out 
in graphics with two fingers.

Softkeys

- 
 
 

The function of the four softkeys depends on the respective situation. The 
currently assigned function appears in the bottom line of the display in the 
form of four touch areas, e.g.: 
<Access> Opens the menu for selecting various accesses 
<Start>: establishes a connection or starts a test

Wheel key

- Opens the setup menu

Menu key

- Opens the quick menu
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4 Quick-start guide
Top connections

 

 

Further variants of the connector panel in the header area, e.g. with OTDR (SC/
APC) or Gigabit Ethernet extension (LAN2, LAN3, SFP2), are explained in the 
corresponding manual or manual chapter.

PWR
For external power adapter.
When the external power adapter is connected, 
The ARGUS switches off the battery power supply.
 

USB-A or USB-A 1/2
USB host interface 
(WLAN)

USB-B (micro USB)
USB client interface (PC connection)

a1/2 or b1/2
4 mm banana socket for copper tests

GND
4 mm banana socket for copper tests (ground 
reference)

 The ARGUS regularly checks 
whether USB devices are connected.
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4 Quick-start guide
Bottom connections
 
Yellow LED “Link/data” signals 
physical connection with another 
Ethernet port
- LED steadily illuminated: 
connecting
- Flashing LED: transmitting/

receiving 

 
PRI/E1
Access PRI/E1 Pin assignment: 1/2, 4/5

Line
The instrument is equipped with two line sockets: 
one RJ11 plugs and one for RJ45 plugs

Analogue/BRI S/T 
access 
G.fast access 
xDSL access 
Copper access 

 
Pin assignment: 4/5 
Pin assignment: 4/5 
Pin assignment: 4/5 
Pin assignment: 4/5

SHDSL
Access  
     SHDSL n-wire

Pin assignment: fixed 4/5,  
variable 3/6, 1/2, 7/8 

LAN1
Connection to a PC network card. Connection to the 
Ethernet interface of an xDSL modem, router (IAD) 
or hub/switch or another Ethernet interface (access: 
Ethernet). 

SFP1
Connection of selected SFP modules from various 
manufacturers, for accessing fibre-based interfaces 
(Ethernet, FTTx/GPON).

Green LED “Speed” and yellow LED 
“Link/Data“ signal Transmission 
speed
- LED on: 10/100 base-T 

- Green Speed LED indicates 
transmission speed

- -LED on: 10/100/1000 base-T
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4 Quick-start guide
LEDs 
 

Power
Lights up green when the device is switched on.
Charge
A flashing green LED indicates that the device is 
charging.
Alarm
Visualizes configured alarms (e.g. DSL).
Test
This LED flashes green when a test, e.g. data, is 
started.  
The LED is continuously green when a connection is 
established.
Protocol 1
This LED flashes green when a test, e.g. data, is 
started. 
The LED is continuously green when a connection is 
established. If the connection could not be 
established, the LED is continuously red.
Sync 1
The LED flashes green while connecting. 
The LED is continuously green when the connection 
is established.
Protocol 2
As Protocol 1, only second line, e.g. for bonding 
connections.
Sync 2
As Sync 1, only second line, e.g. for bonding 
connections.

The LEDs next to the touch display indicate the following:
ARGUS 300 25



4 Quick-start guide
Charging the battery in initial operation

The battery pack compartment is on the rear of the device. Attach the battery back by 
placing it against the retaining points at the top end and then screwing down the screws. 
Use only the battery pack supplied with the device. Observe the safety information given on 
page 13. Now connect your (switched-off) ARGUS to the external power supply supplied 
with the device. 
The ARGUS switches on automatically. The following display appears (you may first need 
to acknowledge warnings or messages with <Continue>):

After pressing the Menu key, select the option “Battery (Status, Charge)” (see image above 
left). Selecting “Status” (see image below left) displays further information, such as voltage 
and current level (see image at right).

The Accesses display can vary 
depending on the configuration.

Current assignment of the softkeys
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4 Quick-start guide
Select “Automatic charging” to toggle the automatic charging functionality on or off.

You can also do this in the ARGUS Manager, which you can access by pressing the power 
key or swiping from top to bottom. Here, touch to toggle automatic charging on and off.

You must first change the battery pack supplied with the device (see page 197, “Using the 
battery pack”) completely before full capacity is reached. 

Power-saving mode

In battery mode, the ARGUS automatically switches off after five minutes of no 
activity (interval adjustable).The ARGUS does not switch off during a test (e.g. loop 
box) or in trace mode.

The device can alternatively be operated using the supplied external adapter. When the 
adapter is connected, power supply via the battery is automatically switched off. 
The ARGUS must always be operated with the battery, regardless of the power supply. 
This ensures e.g. uninterrupted operation of the real-time clock.

Remove the power adapter from the mains socket as soon as the ARGUS is 

switched off or no longer in use (e.g. after charging the battery pack)!
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5 Configuring accesses
5 Configuring accesses

If an access was selected the last time the instrument was used, the ARGUS starts in the 
Access menu.

After selecting <Access>, the ARGUS displays all configured accesses (up to 100 in all). 
The accesses most commonly used in Germany are preconfigured by default. When 
changing accesses, the last access used is indicated on the display with  . 
You can select a different access using the cursor keys or the touchscreen. The selected 
access is marked with a vertical blue line on the left side. Press to confirm your access 
selection. 
The marked accesses also provide a preview of the selected access settings. 
In the example shown here, the access VDSL TE VLAN 7/8 is selected. The access VDSL 
Bond. TE VLAN 7/8 is highlighted, and a preview of the access settings is displayed.
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5 Configuring accesses
The access VDSL TE VLAN 7/8 is highlighted and selected here.

The status line (above the softkeys) displays the selected access.

<New>

<Edit>

<More>

In the status display, the connection sockets that can be 
used for the selected connection are highlighted in 
white.

Creates a new access, see page 30.

Edits an access, see page 30.

The access marked in blue also moves when you scroll through the 
accesses using the  and  keys. In this way, ARGUS enables you to 
create a series of configured accesses so that the most commonly 
required accesses are readily available.

Switches to ARGUS status.
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5 Configuring accesses
5.1 Access wizard

The access wizard prompts for different information depending on the access/interface. 
The prompts for the parameters depend on the parameters that were previously selected. 

Once the access has been selected, you can launch the access wizard in the menu using 
<Edit> (see image at left). The query parameters of the access wizard depend on the 
selected access (ADSL, VDSL, ...). You can now select the physical interface (see image at 
right).

Selecting the number of twisted pairs (see image at left). A twisted-pair connection (dual 
copper cores) is used for normal VDSL accesses and a 4-wire connection is used for VDSL 
bonding accesses. Once this is completed, you can select the access mode (see image at 
right).
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5 Configuring accesses
These preconfigured accesses can be linked to up to 20 profiles. These profiles link the 
access settings with the access and test parameters. You can set various parameters here 
including those for service and virtual line. The selected profile appears in the display in 
blue. The preset profile is indicated in the display with  (see image at left).
Once you have selected the profile, the ARGUS suggests an access name, depending on 
the settings you made previously. You can enter up to 24 characters.

<Delete> Deletes access name

Clears mark and positions cursor keys to the start.

Clears mark and positions cursor keys to the end.

<Abc>ABC> Entry begins with upper-case letters and continues in lower-case.

<ABC>123> Entry of upper-case letters.

<123>abc> Numerical entry.

<abc>Abc> Entry of lower-case letters.

Entry of special characters, e.g. @, /, -, ., *, ?, %, =, &, ! etc.

Entry of special characters, e.g. _, :, +, # etc.
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5 Configuring accesses
The ARGUS displays a summary of the configuration (see image at left).

Once you confirm with Enter, the ARGUS switches to the editing view of the selected 
access (see image at right). To configure the services or test parameters, select  
<Profile>.
You need to exit the access wizard before the ARGUS can use the configured access.

<Physical Parameters> Edits the physical parameters, see page 33.

<Note> Entry of notes, see page 34.

<Copper Test> Editing of parallel copper tests possible.

Go back one level.

Save and exit the wizard.
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5 Configuring accesses
5.2 Physical Parameters

Edits the physical parameters of the selected access. The physical parameters can also be 
opened and edited directly when the access wizard is finished.

5.3 Profile

The preconfigured accesses can be linked to up to 20 profiles. These profiles link the 
access settings with the access and test parameters. You can set various parameters here 
including those for service and virtual line.

Select the profile you wish to edit. The selected profile appears in the display 
highlighted in blue. The default profile is indicated with a  in the display.
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5 Configuring accesses
You can find more detailed explanations of the profiles on the following pages: 
Services starting on page 83.
Profile name: for entering see Access name, page 31.

5.4 Notes

You can also add a note when editing an access. This note can be up to 49 characters 
long.
In addition to the selected access, the ARGUS will display, for example, the xDSL mode, 
the access mode and a freely editable note in the preview (in this example: Dialup with 
VLAN).

For more on entering notices see “Access name” on page 31.
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6 Physical layer
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6 Physical layer

The physical layer (layer 1) is shown in the status screen (Fig. 2) with its own graphical ele-
ment (here VDSL). The other elements in the status screen are initially only named. This is 
explained in more detail on page 69 (Virtual lines) and page 83 (Services). The physical 
layers for the G.fast, ADSL, SHDSL and Ethernet interfaces are presented in the same way 
as for VDSL. The selection of the VDSL access and the access mode VTU-R are directly 
adopted in the status screen. If the defaults are correct, layer 1 (synchronisation on VDSL) 
can be established directly on <Start>. The most important information such as voltage (U) 
and modem states (power down) are displayed in the layer-1 box (blue). To change the 
VDSL configuration directly, press <Edit>. To change the access type directly in the status 

screen (Fig. 2), press the softkey <Access> or the key combination    and  .

Router / bridge  
(only for xTU-R bridge 
and xTU-R router)

Current access and 
softkey assignment

Layer 1

Services, see page 83

Virtual lines 
see page 69

<Edit>

<Access>

<Start>

See page 83 for tests that can be run via layer 1.

Changing DSL settings: see page 

Access selection: see page

Synchronizing: see page



7 Operation on G.fast and xDSL accesses
7 Operation on G.fast and xDSL accesses

ARGUS supports G.fast and the following DSL interfaces: ADSL, VDSL, SHDSL.  
In this connection, ARGUS supports the following access modes: 

The individual DSL tests record and store data (e.g. traces of IP data). It is the 
user's responsibility to comply with the applicable legal requirements.

The line may not carry a DC voltage greater than 200 V DC and should be free of 
AC voltage components.

In principle, the operating temperature range set out in "Technical data" (see 
page 17) applies for SHDSL operation. For ambient temperatures just below +50 
°C, extended operation in high-performance modes can trigger the temperature-
dependent ARGUS protection functions described in the safety information (see 
page 10).

xTU-R Terminal device mode (fast/xDSL transceiver unit) see page 39. 
The ARGUS is connected to the xDSL access (in front of or behind 
the splitter). TheARGUS replaces the modem and PC. 

xTU-R Bridge Bridge mode (fast/xDSL transceiver unit) see page 59. 
The ARGUS is connected to the xDSL access and the PC.  
The ARGUS replaces the xDSL modem (for SHDSL only ATM and 
EFM). 

xTU-R Router Router mode (fast/xDSL transceiver unit) see page 61. 
The ARGUS is connected to the xDSL access and the PC.  
The ARGUS replaces the xDSL modem and router (for SHDSL only 
ATM and EFM). 

STU-C (STU-C: SHDSL transceiver unit-central office) 
The ARGUS simulates the central office side (DSLAM). 
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7 Operation on G.fast and xDSL accesses
7.1 Configuring G.fast and xDSL interfaces

In the ARGUS status, the layer-1 box highlighted in blue is selected.

7.2 G.fast and xDSL settings

The ARGUS stores all relevant settings for a test with the accesses. Only the relevant set-
tings are applied, depending on the test situation. You can restore the default settings at 
any time (see page 192). 

You can make the following relevant settings:
- Rated / threshold value
- INP/SNRM (ADSL only)
- Firmware (VDSL only)
- Carrier Set (VDSL only)
- Vectoring Mode (VDSL only)
- Retransmission (ADSL and VDSL only)
- MAC address
- Gratuitous ARP
- VLAN mode(ADSL only)
- Spectrum (SHDSL only)
- Data rate (SHDSL only)
- Power back off (SHDSL only)
- EOC usage (SHDSL only)
- Sync word (SHDSL only)
- Message mode (SHDSL only)
- Vendor info field (SHDSL only)
- Wire pairs (SHDSL only)
- Line probing (SHDSL only)

- Interop bits (SHDSL only)

<Edit> Opens settings

Note:
accessing functions via number keys/key combinations
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 204.
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7 Operation on G.fast and xDSL accesses
 

When the router box highlighted in blue is selected in the ARGUS status, you can configure 

bridge/router settings.

You can configure the following settings:
- IP version
- IPv4
- IPv6 (router only)
- VLAN (bridge only)
- Data log

<Edit> Opens settings

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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7 Operation on G.fast and xDSL accesses
7.3 The ARGUS in access mode xTU-R

Determining the G.fast xDSL connection parameters using VDSL as an 
example (procedures also apply for ADSL and SHDSL connections) 

The ARGUS is connected directly to the VDSL access via the supplied xDSL lead and the 
ARGUS socket line (either in front of or behind the splitter). In this case, the ARGUS 
replaces the modem and PC. It establishes a VDSL connection and determines all relevant 
VDSL connection parameters. The ARGUS displays the VDSL connection parameters and, 
if desired, saves them when the link is disconnected.

Use only the patch cables supplied with the device.

Socket 
Line

VDSL access 
VTU-C (DSLAM)

xDSL cable or patch cable 
39ARGUS 300 



7 Operation on G.fast and xDSL accesses
Establishing the G.fast and xDSL connection using VDSL as an example
Profile configuration:
The ARGUS uses the settings and limit values stored in the respective profile for 
establishing a VDSL connection. 

Additionally, the default profile is used.

Establishing a VDSL connection

The ARGUS synchronises with DSLAM (LED "Sync/L1" flashes, display shows arrow on 
yellow background).
The ARGUS displays the current connection status (in this example "Initialize") in the layer-
1 box (blue).
The activation time (elapsed time from the start of synchronisation in h:min:s) is displayed 
below the layer-1 box.

Connected

As soon as the connection is established (LED Sync/1 continuously illuminated and green 
check mark in the layer-1 box), the ARGUS determines the VDSL connection parameters 
and displays these below the layer-1 box. After synchronising, the ARGUS must remain 
connected to the VDSL access for at least 20 seconds. Only then can the ARGUS save all 
VDSL connection parameters

<Edit> Changes VDSL settings and MAC address.
<Access> Selects a new access.
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7 Operation on G.fast and xDSL accesses
The layer-1 box displays the following information:

You can open a long-term view (see above) using the <Info> softkey.

Signalling of CRC/FEC error counters:

Symbol Colour left  
and right
green/green No CRC/FEC errors occurred in the last second.

red/red In the last second, CRC/FEC errors occurred in both upstream 
and downstream.

green/red Only upstream CRC/FEC errors occurred in the last second.

red/green Only downstream CRC/FEC errors occurred in the last second.

- Access and access mode
- VDSL profile (8,12,17, 30 or 35 MHz)
- d: downstream net data rate 

u: upstream net data rate
- Number of CRC and FEC errors in down- and upstream
- DC voltage on the interface

Explanation
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7 Operation on G.fast and xDSL accesses
Select the softkey <Parameters> to open a detailed view of the parameters, in this 
example VDSL. You can view more parameters by swiping up and down on the 
touchscreen or using the softkeys (see images above and below).

n/a not available

n/u not used

n/r not received

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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7 Operation on G.fast and xDSL accesses
The softkey “Trace” opens the following view: 

Display of commands: 

Explanation of modem states such as “modem idle” ADSL/VDSL, see page 52 and 
SHDSL, see page 53.

 
Display timestamp: 
The ARGUS indicates the time (internal clock) the commands are received. 
You can display a variety of graphical functions using the <Graph> softkey. The <Menu> 
softkey provides a precise description of the available options.

<Statistic> Displays the statistics.

G.fast and VDSL (EFM) - Ethernet statistics
Frames number of all Ethernet frames received (Rx) and transmitted 

(Tx)
Bytes number of all bytes received (Rx) and transmitted (Tx) 

< = Command sent by ARGUS

> = Command sent by DSLAM

- = Connection status

When the ARGUS status, physical box or DSL trace displays the state “no 
common mode”, this can indicate that the access in question is ADSL and not 
VDSL, or vice versa.

The following graphs and graph functions are only available for G.fast, ADSL and 
VDSL.
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7 Operation on G.fast and xDSL accesses
Displays the bit distribution, i.e. Transported bits per tone (channel)
y-axis: bits
x-axis: tones (channels)
Line interference sources (e.g. due to HDSL, RF, DPBO, etc.) can be identified on the 
basis of the bit distribution.

Graph functions
The graph functions such as zoom, cursor and setting of the x-axis enable detailed analysis 
of the graphs:

If the symbol in the display is black and white ( ), the graph has not yet been zoomed. 

The symbol is green and white when the graph is zoomed ( ).

ARGUS switches to the previous display.

<Continue> Switches to next graph.

Exits the menu without changing.

You can also use this number key to toggle the zoom function within a graph. 

The function of the cursor is described on page 46.

Switching the x-axis from tone to frequency is described on page 47.

Setting the min/max is described on page 48.

Switches automatically to the next graph with the view and adopts all settings for 
this graph
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7 Operation on G.fast and xDSL accesses
 

<Zoom(y)+> Magnifies the middle section of the graph (100%).

<Zoom(y)-> Reverses <Zoom(y)+> and resets magnification

You can horizontally scroll through the zoomed range using the cursor keys 
or by tapping.

You can vertically scroll through the zoomed range using the cursor keys or 
by tapping.

The X-key returns the display to the unzoomed view.
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7 Operation on G.fast and xDSL accesses
The cursor functions enable precise determinations of the graphs.

When the Cursor function is started, a grey cursor line appears in the middle of the graph.

The values of the graph for the position under the cursor are displayed in the graph as 
follows:

Inserts the cursor directly.

<Cursor> You can toggle the cursor on and off as needed using the Cursor softkey after 
activating it in the menu.

x:  2107th tone

y:  7 bits

Use the left and right cursor keys to move the cursor to any point on the graph 
to measure it. Briefly pressing a cursor key causes the cursor to jump to by 
one position in the graph. When the cursor key is held down, the steps the 
cursor covers in the graph become progressively larger.

Use the vertical cursor keys to move the blue frame to the lower or upper 
graphic.
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7 Operation on G.fast and xDSL accesses
By toggling the x-axis (softkey 9) you can change its labelling from tone to frequency.

Available options: 

 

 

The Zoom function and the Cursor function can also be combined. However, the starting 
position of the cursor can vary. The graph functions can be used for all graphs.
If the cursor is displayed while the graph is zoomed, both symbols are green (see image at 
right).

Tone: Displays the values of the x-axis as tones

Frequency: Displays the values of the x-axis as frequencies

 

Direct setting of x-axis.

Use the left and right cursor keys to scroll through the range (in this example 
frequency).
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7 Operation on G.fast and xDSL accesses
With the Min/Max setting, the Bits/Tone and SNR/Tone graphs display the minimum and 
maximum values. 

Display of signal-to-noise ratio (SNR) per tone (see image at left)

Magenta  

 

 

Indicates the maximum value.

Light blue
 

Indicates the minimum value 

<Min/Max off> Hides min/max values.
<Min/Max Rst.> Resets min/max values.

Inserts softkeys directly.

<Continue> Display more graphs.
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7 Operation on G.fast and xDSL accesses
y-axis: SNR in dB
x-axis: tones (channels)

This enables interference sources for individual tones (channels) to be detected, in this 
example downstream power backoff (DPBO).
 

Display of quiet-line noise (QLN) per tone (see image at right). The QLN represents the 
quiet line noise of the twisted pair as a function of the frequency.
y-axis: QLN in dBm/Hz
x-axis: tones (channels)
 
The QLN enables detection of narrow-band interference sources due to e.g. coupling of 
medium-wave emission sources or defective switching components. These interference 
sources are represented as narrow peaks. The example at left shows a line with 
interference from a power supply.

<Menu> Opens the graph functions (see page 44).
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7 Operation on G.fast and xDSL accesses
Displays the amplitude component of the transmission function (HLOG) for each tone. 
HLOG shows the attenuation of a connection as a function of the frequency.
y-axis: Hlog in dB
x-axis: tones (channels)

On a nominally functioning line, the values drop off as the frequency increases; this 
function is virtually horizontal on short lines. This example shows a short line.

In the HLOG graphs, a shift can occur in calculating the upstream and downstream values 
from DSLAM compared to the downstream values from the ARGUS. It can also happen 
that DSLAMs do not transmit the HLOG upstream values or send falsified values.

DSL connections are often possible even though one of the two cores is high-ohm or even 
interrupted (only capacitive coupling). This results in dropped connections and data losses. 
Such problems can be due to oxidized lines, poor contacts in the telephone sockets, loose 
terminals or improperly insulated lines. In connections like this, lower frequencies are 
attenuated much more than higher frequencies. This is recognisable as an atypical 
relationship between upstream and downstream attenuation, as well as in the HLOG curve.
In the event of a problem on one of the wires, the values for the low frequencies are often 
less than for the higher frequencies.

Using the rule of thumb L[m] = 50/f [MHz], you can estimate the length of a stub line if you 
know the frequency in MHz (in this example 0.535 MHz):

L [m] = 50/0,535 MHz = 93 m

There is a stub line approx. 93 m long.
In this example, given a frequency of approx. 3.85 MHz, the stub line is approx. 13 m long.

<Menu> Opens the graph functions (see page 44). 
<Continue> ARGUS returns to the bits/tone graph.
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The ARGUS determines the following xDSL connection parameters:

- Net data rate (ADSL, VDSL and G.fast only)
- Attainable data rate (ADSL, VDSL and G.fast only)
- Relative capacity (ADSL, VDSL and G.fast only)
- Latency mode (ADSL only)
- Attenuation (ADSL and SHDSL only)
- Loop attenuation (VDSL only)
- Signal attenuation (VDSL and G.fast only)
- Output power
- SNR margin
- Impulse noise prot. (ADSL, VDSL and G.fast only)
- Interleave delay (ADSL, VDSL and G.fast only)
- FEC (ADSL, VDSL and G.fast only)
- CRC
- LOSWS (SHDSL only)
- HEC (ADSL only)
- ES
- SES
- LOSS (ADSL, VDSL and G.fast only)
- UAS
- Reset (ADSL, VDSL and G.fast only)
- Resync (ADSL, VDSL and G.fast only)
- Showtime no sync (VDSL and G.fast only)
- Bitswap events (ADSL, VDSL and G.fast only)
- Vectoring (VDSL only)
- SRA (Seamless Rate Adaption) (VDSL and G.fast only)
- Retransmission (G.INP) (ADSL, VDSL and G.fast only)
  - Data transmission units (DTU) (VDSL and G.fast only)
  - INP REIN (VDSL and G.fast only)
  - INP SHINE (VDSL and G.fast only)
  - ETR (VDSL and G.fast only)
- Elec.length@1MHz (VDSL and G.fast only)
- Vendor far (ADSL, VDSL and G.fast only)
  - Version (ADSL, VDSL and G.fast only)
- Vendor near (ADSL, VDSL and G.fast only)
  - Version (ADSL, VDSL and G.fast only)

You can obtain further information on parameters in the ARGUSpedia on the 
instrument.
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System information for transmission to the ADSL/VDSL remote station
When a modem is synchronised with a DSLAM, the vendor and device type of the 
modem is generally displayed in the control system of the DSLAM.
For ADSL and VDSL, this occurs according to ITU-T G.997.1.
When an ARGUS device synchronises with a DSLAM, the latter reports to the 
control system the following:

Meaning of the modem states:

Information Display in DSLAM Meaning

System vendor ID 0x04, 0x00 (hex) Country code: Germany

INGE or 
0x49, 0x4E, 0x47, 0x45 (hex)

Provider code: 
intec Germany

0x19, 1x01 (hex) System FW version: 1.90.0

Version number R1.90 U_ Device FW version: 1.90.0

Serial number ARGUS300-9999-R1.90.0U_ Device type: 
ARGUS 300/device serial 
number 9999

Colour Short form Explanation

red No-load

light 

blue

ARGUS transmits handshake tones (silence 
on the DSLAM side).

yellow A handshake (G.hs) signal from the remote 
station was detected.

orange Start of the training phase following 
successful handshake.

green Showtime achieved. The TC sublayer is 
established. ARGUS is ready for operation.
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7 Operation on G.fast and xDSL accesses
System information for transmission to the SHDSL remote station 
When a modem synchronises with DSLAM, the vendor
and device type of this modem are normally displayed in the DSLAM's control  
system. In SHDSL, this is carried out according to “ITU-T G.991.2
table 9-10". When an ARGUS device synchronises with a DSLAM, the latter 
reports to the control system the following:

Info: Entry: E.g. ARGUS:

Vendor ID intec name „intec“

Version model Device type „Argus300“

Vendor serial Serial number „9999“

Other vendor information Device SW „R1.90.0 U_“

Meaning of the running EFM states (from the STU-R perspective)

Power down STU-R / STU-C in idle state.

Initialization red Initialisation - „power on“.

GHS startup light 
blue

Handshake according to ITU-T 
G.994.1, G.hs is started. 

GHS transfer yellow Replacement of the capability list 
completed.

Discovery Start of the discovery phase.

Discovery 
accepted

Discovery probe accepted.

Discovery 
finished

Discovery phase finished.

Aggregation 
accepted

Aggregation probe accepted.

Aggregation 
finished

Aggregation phase finished.

GHS finished orange Handshake (G.hs) successfully 
completed.

Data green Data mode achieved, showtime.

Data Error An error, e.g. loss of sync. has 
occurred.
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7 Operation on G.fast and xDSL accesses
Disconnecting the G.fast and xDSL connection and saving the results

Select <Stop> to disconnect the live connection. You can now save the results (see image 
at right):

<No>

<Back>

<Yes>

Results are rejected

Results are not saved. The ARGUS returns to the status display.

Saving the result
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7 Operation on G.fast and xDSL accesses
The ARGUS saves the connection parameters together with the trace data in the first free 
slot. You can enter a user-definable name when saving (see page 177). The ARGUS 
automatically suggests a name for saving the data that is made up of the following 
information:
- Device type (here A300)
- Serial number (here 1324)
- Configured date (here 01 March 2021)
- Set time (here 09:15)
 
If all slots are occupied, you need to manually select a slot to overwrite. Press OK or check 
the box on the touchscreen to confirm saving the data.
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7 Operation on G.fast and xDSL accesses
Saving the results without disconnecting the G.fast or xDSL connection

You can save the results while the connection is active in the quick menu, without discon-
necting. The option “Save measurement log” is not greyed out while the connection is 
active. The save name is generated in the same way as for a disconnected connection.

Displaying saved test results

You can now select the various measurement logs using the option “Measurement logs” in 
the quick menu.
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7 Operation on G.fast and xDSL accesses
These are displayed in the browser. You can view the results in detail by swiping the touch-
screen or using the cursor keys (status screen at left, configuration screen at right).

Illustration at left VDSL general, illustration at right bits/tone pair 1.
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7 Operation on G.fast and xDSL accesses
Clicking the menu key ( ) opens a menu that displays various details of the measure-

ment log. The respective item opens at a touch.
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7 Operation on G.fast and xDSL accesses
7.4 The ARGUS in access mode xTU-R bridge

Connect ARGUS to the PC using the patch cable and to the VDSL access using the xDSL 
cable. In bridge mode, ARGUS behaves like a VDSL modem, i.e. it passively conducts all 
packets from Ethernet to VDSL (and vice-versa). In this case, the PC is responsible for 
establishing the connection.

Patch cablexDSL cable

Socket LAN 1/2 / SFP 1

Ethernet VDSL 

  VDSL 
access

PCProtocol, e.g. PPP

Socket Line

 
The ARGUS in access mode xTU-R bridge
In this example, VDSL VTU-R mode is configured and selected as described in Chapter 5, 
“Configuring accesses” (see page 28).

<Edit> VDSL settings
<Access> Change access
<Start> Start VDSL 

Switch to bridge mode using the cursor keys or touch display.
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7 Operation on G.fast and xDSL accesses
Establishing a VDSL connection

Establishing the VDSL bridge

The VDSL connection is established (green check mark in the layer-1 box).

The bridge can also be activated directly. If layer 1 has not yet been established, this is 
automatically started as well.

 

<Stop>

<Info> 

Switches to the layer-1 box and other elements, see page 70 for explanation. 

<Edit> Bridge/router parameter settings

Deactivates bridge mode

Displays the activity of bridge mode.

When the physical layer is active (ADSL only), you can run the following tests using the 
softkey <Test>, see page 83.

No tests are available when bridge mode is active. 

Displays the connection parameters.

<Info> or 
Displays VDSL connection parameters, see page 42.

<Stop> Disconnects the VDSL connection and automatically 
deactivates the bridge.
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7 Operation on G.fast and xDSL accesses
7.5 The ARGUS in access mode xTU-R router

Connect the ARGUS to the PC using the patch cable and to the VDSL access using the 
xDSL cable. In router mode, the ARGUS replaces both the modem and the router, so that 
multiple PCs can access a network connection (via a hub/switch). The IP addresses of the 
network are either issued statically or the ARGUS is designated the DHCP server and 
assigns IP addresses to the connected PCs.

Settings for xDSL, see page 37:

Settings in access mode xTU-R bridge
In this example, VDSL VTU-R router mode is configured and selected as described in 
Chapter 5, “Configuring accesses” (see page 28).

<Edit>

<Access>

<Start>

Switch to Router using the cursor keys.

VDSL setting

Change access

Start VDSL 

Ethernet 

VDSL 

Ethernet 

Hub/switch

Ethernet 
LAN 1/2, 
SFP1 

  VDSL 
access

PC 

PC 

e.g. PPP IP

 
The ARGUS does not have 
a firewall!
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7 Operation on G.fast and xDSL accesses
The VDSL connection is activated and the virtual line selected (see picture at right).
 

<Edit>

Switch to “Router with the cursor keys or using the touch screen.

The router is selected (see image at right).

The router can also be activated directly. If layer 1 has not yet been established, this is 
automatically started as well.

<Edit>

<Start>

 

When the physical layer is active (ADSL only), you can run the following tests using the 
softkey <Test>, see page 83.

 No tests are available when router mode is active.

Parameter configuration, see Chapter 9 Virtual lines (VL) (see page 69).

Configuring the bridge/router parameters.

See page 59 for bridge mode display and operation.
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7 Operation on G.fast and xDSL accesses
7.6 The ARGUS in access mode STU-C

Determining the SHDSL connection parameters
The ARGUS is connected to the SHDSL modem directly using the supplied xDSL, patch, 
SHDSL 4-wire or SHDSL 8-wire banana cable. In this case, the ARGUS replaces the 
DSLAM (STU-C). The ARGUS establishes a SHDSL connection and determines all 
relevant SHDSL connection parameters. The ARGUS displays the SHDSL connection 
parameters and, if desired, saves them when the link is disconnected.

The procedure is the same for SHDSL 2-wire ATM, SHDSL 4, 6 and 8-wire connections 
and for EFM.

 
Use only the patch cable supplied with the device. 
 

 

Configuring access mode STU-C:
SHDSL VTU-C mode is configured and selected as described in Chapter 5, “Configuring 
accesses” (see page 28). 

Connecting SHDSL on the STU-C side:
Connect STU-C and display the connection parameters via <Info> as for VTU-R, see 
page 61.

When the SHDSL physical layer is active, you can run the following tests using the softkey 
<Test>, see page 83.

SHDSL modem or another 
ARGUS (STU-R)

Socket 
Line

e.g. xDSL cable or patch cable 
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8 Operation on the Ethernet access
8 Operation on the Ethernet access

The ARGUS supports the following in Ethernet operation:

The individual tests acquire and store data. It is the user's responsibility to comply 
with the applicable legal requirements.
 

 

Patch cable

Socket LAN 1/2, SFP 1

Ethernet 
e.g. xDSL or 
G.fast 

Connecting to a modem:

Modem

e.g. xDSL 
access

 

Patch cable

Socket LAN 1/2, SFP 1

Ethernet 
e.g. xDSL or 
G.fast 

Connecting to a router modem:

Router 
modem

e.g. xDSL 
access

Socket LAN 1/2, SFP 1

Ethernet 

Connecting to a PC via IP

PC
Patch cable
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8 Operation on the Ethernet access
 

8.1 Configuring Ethernet accesses

Configuring the Ethernet interface is described in Chapter 5, “Configuring accesses” (see 
page 28.

Note: accessing functions via number keys/key combinations
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 204.

Socket LAN 1/2, SFP 1

Connecting to an IP network

Ethernet 

Hub/switch
Patch cable

PC

PC
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8 Operation on the Ethernet access
8.2 Ethernet configuration

You can modify the Ethernet settings as described for VDSL, see page 37. 

You can configure the following settings:
- Autonegotiation
- MAC address
- Gratuitous ARP

 
 
Autonegotiation/Ethernet link parameters
Ethernet link autonegotiation is supported by default! Setting: autonegotiation "on"
When negotiating the link parameters, ARGUS informs the remote station that the following 
is supported (these settings are fixed and cannot be configured):

- Speed: 10 or 100 Mbit/s

- Duplex: full or half

- Flow control on/off (for on: symmetric and asymmetric pause)

Manually configuring the Ethernet link parameters: autonegotiation "off"
When autonegotiation is deactivated, the speed, duplex and flow control ("pause" method) 
can be configured in the profile (see above).

- 10 or 100 Mbit/s, default: 100 Mbit/s
- Half or full duplex, default: full
- Flow control on/off ("Flow control off" is only useful in full duplex mode), default: on

Unilateral autonegotiation
When an end user device with autonegotiation “on” encounters a device without 
autonegotiation, no information is sent by the remote station. Even without auto-

negotiation, the speed is determined using the pulse method/idle pattern. In this case, the 
terminal device with autodetection generally drops back to half duplex (duplex mismatch 
possible), which can result in a duplex mode conflict with "poor throughput".

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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8 Operation on the Ethernet access
8.3 Establishing an Ethernet connection

The ARGUS uses the default profile to establish an Ethernet connection.

<Info> Displays Ethernet connection parameters

<Stop> Terminates Ethernet connection

 
Display (see image at right):

- Autonegotiation setting 

- Autoneg. at other end

- Negotiated speed 

- Type of duplex mode

- Flow control setting 

<Statistic> Opens Ethernet statistics
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8 Operation on the Ethernet access
The polarity and offset between the wires are displayed beneath the layer-1 box and in Info.

Statistic display: 

Disconnecting the Ethernet connection and saving the results
You can disconnect and save the results from an Ethernet connection as described for 
VDSL, see page 54.

Saving the results without disconnecting from the Ethernet connection
You can save your results for an Ethernet connection without disconnecting in the same 
way as for VDSL, see page 56.

- Wire allocation

Left 
column

ARGUS wire allocation

Right 
column

ARGUS wire allocation after autonegotiation with remote 
terminal. When the display shows "OK", the remote station 
has inverted the wire allocation.

- Polarity

- Offset in ns

<Statistic> Opens Ethernet statistics

- Received (Rx) and transmitted (Tx) internet frames

- Received (Rx) and transmitted (Tx) bytes

- Number of errors on the receiver (Rx) and transmitter (Tx) side

- Number of collisions
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9 Virtual lines (VL)
9 Virtual lines (VL)

Virtual lines (VL) compile the configurations of layer 2 and layer 3 into profiles, called VL 
profiles. These profiles contain e.g. information on protocols, VPI/VCIs, VLANs and PPP 
data (stored in their own subordinate PPP profiles). Virtual lines can be used to conduct 
tests across multiple VPI/VCIs or VLANs and across different protocols.
The ARGUS allows you to define up to 20 such VL profiles. In a VL profile, you can edit e.g. 
the protocol configuration. The VL profiles can be assigned to one or more services inde-
pendently of the state of the physical layer (layer 1). Thus, a data test (e.g. IP-ping) and a 
VoIP test (e.g. VoIP call) can be performed on a single active access without having to re-
establish layer 1 (G.fast, DSL, Ethernet) in spite of differing protocols.

9.1 Virtual lines in the status screen

The virtual lines in the status screen are explained using the access VDSL VTU-R router as 
an example:
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9 Virtual lines (VL)
Router / bridge  
(only for xTU-R bridge 
and xTU-R router)Services, see page 83

Virtual lines 
see page 69

Layer 1

Current access and 
softkey assignment

Virtual line for 
bridge/router,  

The status screen is divided into three levels that can be individually selected using the cur-
sor keys of the ARGUS keypad.
The status screen is described in greater detail using three display examples.

<Edit>

<Access>

<Start>

Level 1: physical layer (see image at left)

Level 2: Virtual lines

<Edit>

 (see middle illustration)

 

 -Possible configurations:
- Protocol (IP, PPP, PPTP)
- ATM
- VLAN
- PPP (PPP profiles)
- PPTP
- APN

Configure physical layer

Access selection

Establishes physical layer of the selected access.

Configure virtual line, see page 74.
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9 Virtual lines (VL)
- IP version (IPv4, IPv6, dual)
- IPv4
- IPv6
- BGP
- Data log (for this VL)
- Profile name

<Profile>

 

Level 3: Services 

<Edit>

<Profile>

<Start>

 (see illustration at right)

 
The virtual line and the physical layer also start automatically when you press the softkey 
<Start>.

Depending on the status of the physical layer, the virtual lines or the services, the ARGUS 
displays a variety of symbols in the status screen.

 
This service has not yet been assigned to a virtual line.
 
This service, VL or physical layer is idle.
 
This service is not available (bridge mode only). 
 
Preparing activation of physical layer, VL or service. 
 
Activating the physical layer, VL or service. 
 
Physical layer, VL or service deactivated due to an unexpected occurrence. 
 
Deactivating.
 

Synchronisation achieved (physical layer) or a VL or service was activated successful-
ly without errors. 
 
A test is currently running in this service.

An error occurred here. Reset with <Reset> to continue with the VL.

Configures the profile.

Assign a VL to a service and configure it

Configure profile

Start service
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9 Virtual lines (VL)
9.2 Virtual line profiles (VL profiles)

The various profile types are explained below:

Profiles (1 - 20), see page 35

-

-

-

VL profiles (Virtual lines 1 - 20 )

-

-

-

-

PPP profiles (1 - 20)

-

-

-

These contain the assignments of the services (Data, VoIP, IPTV, Opt.) to one or more 
virtual lines.

In addition to the services, the settings for the bridge/router and the test parameter can 
be found here as well.

Each profile can be assigned an individual profile name.

These contain the layer 2/3 settings.

VL profiles are assigned to services.

One VL can be assigned to multiple services.

PPP profiles can be assigned to the VL profiles.

They contain all relevant data for dialling.

PPP profiles are assigned to VL profiles.

A PPP profile can be assigned to multiple VL profiles.
72 ARGUS 300



9 Virtual lines (VL)
9.3 Virtual line activation
A service or test must be started in order to activate a virtual line. To enable a test to be 
started, a service must be configured, and a virtual line assigned to it. In this example, the 
service DATA is configured and assigned to a virtual line. 

9.3.1 Starting a service

The VDSL connection is active (see image at right). 
 

<Start>

The physical layer (VDSL), the virtual line and the service Data are now active. This is indi-
cated by a green check mark.

<Info>

<Stop>

 

For an explanation of the services, see page 83.

 

Use the cursor keys to switch from the layer-1 box over the virtual line to the service 
Data.

If the physical layer is not yet active, this is started automatically with the service 
or test.

Starts the service.

Displays service Data information (e.g. duration of activity).

Terminates service Data.
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9 Virtual lines (VL)
The tests that can be run using the service Data are displayed.

<Setting>

9.3.2 Assigning additional virtual lines

The ARGUS can use multiple services concurrently (e.g. Data and VoIP) via a single virtual 
line. In this example, VDSL is active. The service Data is selected. The following explains 
how multiple services can be connected via a single virtual line.

Configures the respective test (in this example IP ping). You can find 
a detailed description starting on page 85.

To configure a virtual line (in this example for the service Data) for other services, 
you must first stop the service. The physical layer remains active.

The service VoIP is greyed out when the VoIP option is not set.

 

Using the cursor keys, select the service VoIP.
74 ARGUS 300



9 Virtual lines (VL)
<Edit>

Select "Virtual line".

<Edit>

 

Edit the selected VL profile. 

Opens PPP profile selection.

Opens the configuration of the selected service (in this example VoIP).

Select the virtual profile you wish to edit. The selected profile appears in the display 
in blue.

Unavailable elements are greyed out, for instance when they are currently active.

Edits the settings.

 
e.g. select PPP
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9 Virtual lines (VL)
Select profile.

Up to 20 PPP profiles can be configured.

The services Data and VoIP are now connected to the physical layer (VDSL access) via a 

virtual line (see image at right).

<Start>

 

The service VoIP is now active (see image at right). You can now run a variety of tests via 
the service VoIP.
In the next step, you can activate a further service.

 
e.g. select PPP profile 1

Press the Back key four times to return to the Service VoIP menu.

Starts the service VoIP
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9 Virtual lines (VL)
Select Data using the cursor keys and press <Start> to activate the service.

The services Data and VoIP are active. You can now run a variety of tests via the services 
Data and VoIP.

The display and operation for IPTV and Opt. are the same as for VoIP. 

Further examples of different virtual-line assignments:

Example 1 (illustration at left):
One virtual line is connected with the service Data and another with the service VoIP. The 
virtual line for VoIP can thus be used for different protocol data than the virtual line for Data.

Example 2 (illustration at right):
One virtual line was configured for the services VoIP, IPTV and Opt. In this example, the 
services IPTV and Opt. are active.

Up to four virtual lines can be established for the service IPTV. However, the 
ARGUS only displays these as a single composite virtual line. A detailed 
description is provided in the chapter IPTV, see page 138.
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9 Virtual lines (VL)
Example 3:
In this example, each service was assigned a virtual line.
The services are unavailable because the ARGUS is in bridge mode.

9.4 PPP wizard

Up to 20 PPP profiles can be configured.

<Edit>

 
Select PPP.

Edit the selected PPP profile.
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9 Virtual lines (VL)
9.5 Virtual line settings

The following virtual line settings can be configured:
- Protocol
  - IP
  - PPP
  - PPTP
- ATM
  - VPI/VCI
  - Encapsulation
  - ATM with Ethernet
- VLAN
  - no VLAN
  - 1 VLAN tag
  - 2 VLAN tags (QinQ)
- PPP
  - PPP profile 1-20
    - Profile name
- PPTP
- APN
- IP version
  - IPv4 only
  - IPv6 only
  - Dual stack IPv4/IPv6
  - Dual stack lite
- IPv4
  - IP mode
  - Own IP address
  - Netmask
  - Gateway
  - DNS server
  - DHCP client
  - DHCP server
- IPv6
  - AFTR
  - DHCP client
- BGP
- Data log
- Profile name

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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9 Virtual lines (VL)
9.6 Displaying protocol statistics

Depending on the access mode and the protocol, the ARGUS displays BRAS, IP, PPP, 
ATM or Ethernet statistics.

The physical layer, the virtual line and the service Data are now active.

 
When you select “Info”, the ARGUS displays the BRAS (only for PPP protocol) and the IP, 
PPP and Ethernet information (only for PPP) protocol).

Broadband Access Server (BRAS) information
- AC (access server) name: name of server
- Service name: name of service
- Session ID: Number of this connection

<Info> Shows G.fast and DSL results

<Stop> Physik, VL und Data deaktivieren

Switches to the virtual line (VL) using the cursor keys or the touch screen.
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9 Virtual lines (VL)
<Trace>

PPP information:
The ARGUS displays the received (Rx) and transmitted (Tx) PPP packets and the bytes.

Ethernet information:
The ARGUS displays the received (Rx) and transmitted (Tx) Ethernet frames and the 
bytes.

IP information:
The ARGUS displays the IP information as a function of the IP version.

IPv6 (illustration at left): The ARGUS displays the IP configuration assigned by the server:
- Global unicast address
- Link local address
- DNS address

IPv4 (illustration at right): The ARGUS displays the IP configuration assigned by the server:
- Received IP address
- Gateway IP address
- Available DNS servers

Opens a PPP trace, which displays the PPP login process. It also assigns the 
individual messages to times according to the ARGUS system clock.
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9 Virtual lines (VL)
Display of commands

-

-

-

-

-

-

-

-

-

Table of abbreviations: 

< = Command sent by ARGUS

> = Command sent by DSLAM

PADI: PPPoE Active Discovery Initiation

PADO: PPPoE Active Discovery Offer

PADR: PPPoE Active Discovery Request

PADS: PPPoE Active Discovery Session Confirmation

PADT: PPPoE Active Discovery Termination

IPv6 CP: IPv6 Control Protocol

LCP: Link Control Protocol

IPCP: Internet Protocol Control Protocol

PAP: Password Authentication Protocol

Abbreviation Meaning

ack. acknowledge

auth. authentication

conf. configuration

nak. not acknowledge

prot. protocol

rec. received

rep. reply

req. request

rej. rejected
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10 Services + tests
10 Services + tests

The status screen (see explanation on page 69) shows four services. 
Each service can be used to conduct an entire suite of IP tests (see list below).  
It is also possible to start and stop each service independently of the others.

Example screen with the possible services:

 

See page 206 for an explanation of the symbols.

Once a service is activated, a variety of tests can be started using <Test>. 

<Edit> Assigns the service a VL profile and configures the service.
<Profile> Configures the profile.
<Start> Activates the service. If virtual lines and the physical layer are not active, 

they are also automatically started.

Services:

- IP ping - IP ping - IP ping - IP ping

- Traceroute - Traceroute - Traceroute - Traceroute

- Path MTU - Path MTU - Path MTU - Path MTU

- iperf-Client - iperf-Client - iperf-Client - iperf-Client

- iperf-Server - iperf-Server - iperf-Server - iperf-Server

- ARGUS® Real 

  Speed

- ARGUS® Real 

  Speed

- ARGUS® Real 

  Speed

- ARGUS® Real 

  Speed

- Speedtest® by

  Ookla®

- Speedtest® by

  Ookla®

- Speedtest® by

  Ookla®

- Speedtest® by

  Ookla®

- HTTP download - VoIP call - IPTV - HTTP download

- HTTP upload - VoIP call acceptance - IPTV zapping test - HTTP upload

- FTP download - VoIP call generator - IPTV Monitor - FTP download
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10 Services + tests
 
Possible tests that can be executed using the various services.

10.1 Displaying service statistics

The ARGUS in the status screen. The physical layer, VL and service are active. The 
duration of the activity is shown beneath the physical layer (see image at left).

The VoIP call parameters are displayed here in the service VoIP (see image at right), see 
page 130.

- FTP upload - FTP upload

- FTP server - FTP server

- Web browser - Web browser

- Video on demand

*1 Ethernet only
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11 IP tests
11 IP tests

11.1 IP ping

In IP ping, the ARGUS tests whether a connection to the internet service provider (ISP) or 
another computer or server address is possible via Ethernet, G.fast or xDSL using a 
DSLAM and the IP network. The ARGUS sends a test packet to a specified IP address 
(remote station) and waits for a response packet. On the basis of the received response 
packet, it is possible to draw conclusions as to the availability and delay of the IP network. 
It is also possible to measure the maximum data packet size of the path. 

The IP ping needs the following parameters:

Protocol-independent parameters
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

You can configure the following settings:
- IP address
- Number of pings
- Pause
- Packet size
- Fragmentation

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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11 IP tests
The ARGUS displays the ten available slots for IP addresses. Mark the line with the IP add-
ress you wish to edit using the cursor keys or the touch screen (in this example the first slot 
is marked, see image at left).

<Edit>

The address can be saved in the form of an IPv4 number, IPv6 number or a name (see 
image at right).
Default: www.argus.info

Edits the selected IP address.

Enter the IPv4 (see left image) or IPv6 address (see right image) in numerical form. The 
editable area is highlighted in blue. Enter the address using the number keys.
<Delete> Deletes the place in front of the cursor.

 

to  

When entering an IPv6 address, the letters A-F are available.

Adopts the marked IP address as the default.

Toggle entry using the softkey (right softkey changes the meaning when pressed). 
Enters the address as name, see Access name, page 36. You can also enter the name 
by tapping characters on the touch screen.
<Abc>ABC> Entry begins with upper-case letters and continues in lower-case.
<ABC>123> Entry of upper-case letters.
<123>abc> Numerical entry.
<abc>Abc> Entry of lower-case letters.
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11 IP tests
or

Entry of special characters, e.g. @, /, -, ., ...

_, :, ~, +, ...

Moves the cursor in the display line.

For IPv6 addresses, you can use square brackets to include port information 
with IPv6 addresses in “IP address as name”.
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11 IP tests
Starting IP ping (example access mode VTU-R, already active):

Connecting the service:

The profile shown in the display (in this example PPP VLAN 7/8) is used for IP ping.

<Edit>

If no xDSL or Ethernet connection is established, ARGUS automatically connects at this 
point using the default profile (see page 40).

The service Data and the VDSL connection are active (see image at right).

<Info>

<Test>

<Stop>

Assign a virtual line to the service Data. 

Duration of activation

Opens test selection

Deactivates the service
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<Setting>

The ARGUS displays the addresses stored in the protocol.

<Edit>

Pressing OK automatically starts the IP ping. 

 
Select IP ping.

Change IP ping parameters.

Select the address for the ping; the default is indicated with  .

Edit address, see page 85.

In this example a ping test is conducted with IP version IPv4. Use with IPv6 is 
analogous.
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In the status screen, you can select <Test> (at the top) to see which IP ping is currently 
running (see image at left).

Selecting <Test> again opens the test overview. During the IP ping test, a green hammer 
can be seen to the right of "IP ping" (see top right image), and an arrow appears there after 
the IP ping test is complete (see bottom right image).

Display during the IP ping test:

Display after the IP ping test:

<Detail>

The ARGUS displays the results when the test is finished:

- Number of test packets sent

- Number of response packets

- Current time in ms

- Maximum time in ms

- Number of test packets sent

- Number of response packets

- Average time in ms

- Maximum time in ms

Opens a detailed overview of the test results.

- Number of packets sent

- Number of packets received

- Number of packets repeated

- Checksum errors

- Number of packets received with error

- Minimum packet response time in ms
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<Restart>

<Stop>

 

Press Back to return to the test overview. You can start a new test as needed by selecting 
<New>. The xDSL link and the service are still connected (the connection can be 
disconnected in the status screen with <Stop>).
The test overview displays multiple active and completed tests (see image).

 

- Maximum packet response time in ms

- Average packet response time in ms

- Selected packet size in bytes

- Display of destination URL

- Display of IPv6 address

- Display of IPv4 address

- Indication whether IPv4 or IPv6 is used

Starts a new IP ping test.

Stops the IP ping test with the option to save.
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Error messages in IP ping
ARGUS displays an X in a red field in the status for data and VL as soon as an error occurs 
(see image at left). Clicking “Info” displays the error message (see image at right).

 
Open the test overview to obtain more detailed information on the source of the error (see 
image).
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11.2 Traceroute

In IP traceroute, the ARGUS sends test packets and displays all hops and their response 
times on the way to the destination address. This data enables precise localisation of 
possible delays in the network.

The following parameters must be saved in the profile for the IP traceroute:

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

The following test parameters can be configured:

- IP address

- Maximum hops

- Probes

- Timeout

Starting traceroute

(Example: access mode VTU-R, already active)

Connecting the service.
The profile shown in the display (in this example profile 1) is used for the traceroute test.

<Edit>

 

You can obtain further information on settings in the ARGUSpedia on the 
instrument.

Assign a virtual line to the service Data.
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If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).
The service Data and the VDSL connection are active (see image at right).

<Setting>

The ARGUS displays the IP addresses or URLs saved in the protocol (see image at left).

<Edit>

 
Select traceroute

Change traceroute parameters, see page 93.

Select the address for the traceroute test; the default is indicated with  .

Edit address, see page 85.
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The traceroute test starts automatically.

Display during the traceroute test (see image at right):

Open “Details” to display the IP addresses of the individual hops and any names as well as 
their response times, for example: 217.5.90.126, 0.013 s.
This also shows the destination URL and the IP address as well as the IP version used.

Saving traceroute result see also IP ping (see page 91).  

In this example a traceroute test is conducted with IP version IPv4.  
Use with IPv6 is analogous.

- Current hop and probe, in this example:  
7 - 1: i.e. 7th hop and 1st probe 

- Response time of hop for current attempt (0.000 seconds)

- IP address of the current hop, with name if applicable

Cancels test
Displays the test results up to this point, with possibility of saving 
(automatic prompt).
ARGUS 300 95



11 IP tests
11.3 Path MTU test

The Path MTU test is a standalone part of ARGUS® Real Speed (RFC6349). The test 
determines the maximum packet size that can reach a destination without fragmenting 
packets. 
 

The Path MTU test needs the following parameters:

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

The following test parameters can be configured:
- IP Address
- Pause
- Timeout
- Number of Packets 

Starting Path MTU (Example: access mode VTU-R, already active):

 
 

Connecting the service. 
 
The profile shown in the display is used for the Path MTU test.

<Edit>

If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).
The service Data and the VDSL connection are active (see image at right). 

You can obtain further information on settings in the ARGUSpedia on the 
instrument.

Assign a virtual line to the service Data.
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<Info>

<Test>

<Stop>

<Setting>

The ARGUS displays the addresses saved in the profile.

<Edit>

The Path MTU test starts automatically.
In the test overview you can observe the running test.

Duration of activation

Opens test selection

Deactivates the service

 
Select Path MTU.

Change Path MTU parameters.

Select the address for the Path MTU test; the default is indicated with 
.

Edit the address.

In this example a Path MTU test is conducted with IP version IPv4.  
Use with IPv6 is analogous.
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11.4 iperf Client

The iperf client is a data throughput test against an iperf server.

The iperf client needs the following parameters:

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

You can configure the following settings:
- IP Address
- Version
- Test Direction Version 2
- Test Direction Version 3
- Port Version 2
- Port Version 3
- Protocol
- Bandwidth Limit
- Test Duration
- Window Size 

Starting iperf Client (Example: access mode VTU-R, already active):

Connecting the service. 
 
The profile shown in the display is used for the iperf Client.

<Edit>

You can obtain further information on settings in the ARGUSpedia on the 
instrument.

Assign a virtual line to the service Data.
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If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).

The service Data and the VDSL connection are active (see image at right). 

<Info>

<Test>

<Stop>

<Setting>

The ARGUS displays the addresses saved in the profile.

<Edit>

The iperf Client test starts automatically.

Duration of activation

Opens test selection

Deactivates the service

 
Select iperf Client.

Change iperf Client parameters.

Select the address for the iperf Client; the default is indicated with .

Edit the address.

In this example an iperf Client is conducted with IP version IPv4.  
Use with IPv6 is analogous.
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In the test overview you can observe the running test.
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11.5 iperf Server

The iperf server is the remote station for a data throughput test with an iperf client.

The iperf server needs the following parameters:

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

You can configure the following settings:
- Version
- Port Version 2
- Port Version 3 

Starting iperf Server (Example: access mode VTU-R, already active):

Connecting the service. 
 
The profile shown in the display is used for the iperf Server.

<Edit>

If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).

The service Data and the VDSL connection are active (see image at right). 

You can obtain further information on settings in the ARGUSpedia on the 
instrument.

Assign a virtual line to the service Data. 
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<Info>

<Test>

<Stop>

<Setting>

The iperf Server starts automatically.

In the test overview you can observe the running test.

Duration of activation

Opens test selection

Deactivates the service

 
Select iperf Server.

Change iperf Server parameters.
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11.6 ARGUS® Real Speed

ARGUS® Real Speed is an RFC6349 test against an iperf server.

The ARGUS® Real Speed needs the following parameters:

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

You can configure the following settings:
- IP Address
- Version
- Port Version 2
- Port Version 3

- Test Duration

Starting ARGUS® Real Speed (Example: access mode VTU-R, already active):

Connecting the service. 
 

The profile shown in the display is used for the ARGUS® Real Speed.

<Edit>

If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).

The service Data and the VDSL connection are active (see image at right). 

You can obtain further information on settings in the ARGUSpedia on the 
instrument.

Assign a virtual line to the service Data. 
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<Info>

<Test>

<Stop>

<Setting>

The ARGUS will display the addresses saved in the profile.

<Edit>

ARGUS® Real Speed starts automatically.

In the test overview you can observe the running test.

Duration of activation

Opens test selection

Deactivates the service

 
Select ARGUS® Real Speed.

Change ARGUS® Real Speed parameters.

Select the address for the ARGUS® Real Speed; the default is indicated 
with .

Edit address.

In this example an ARGUS® Real Speed is conducted with IP version IPv4.  
Use with IPv6 is analogous.
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11.7 HTTP download

In HTTP download, the ARGUS downloads the data of a website or file. The ARGUS 
displays the current "net download rate", the usable data of the IP packets, and following 
conclusion of HTTP download the average speed (for multiple download attempts). 
The following parameters must be saved in the profile for the HTTP download:

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. 
Therefore, the download file should be as large as possible (depending on the 
access speed). If the duration of the test is less than 10 seconds, the ARGUS 
does not display any data rate or time.

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

The following test parameters can be configured:
- Server Profile
  - Server Address
  - FTP Port
  - Download Filename
  - Upload Filename
  - Upload Filesize
  - Username
  - Password
  - Number of Up-/Downloads
  - Number of Parallel Downloads
  - Number of Parallel Uploads
  - Profile Name

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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If a www alias address is entered as the "Source/destination address", the 
ARGUS downloads "only" the HTML page in HTML download. The ARGUS does 
not evaluate the HTML code, so that any link to a "real" www address is not 
considered. In this case, the ARGUS does not indicate an error, as the HTML 
page of the specified "Source/destination address" was loaded without error.

Be sure to enter the “source” address (server address and download file name)  
precisely as set out (upper/lower case). Otherwise the ARGUS will return error 
301 (Moved Permanently) or 404 (Not Found).

When requesting multiple download components, the ARGUS may reduce the 
number of downloads depending on the server support, which can cause 
deviations from the set parameters. This can occur e.g. as soon as the size of the 
requested file is unknown.

If the download file name exceeds the maximum permissible length, you can 
work around this limit by fragmenting the address and additionally using the 
"Server" field. The server name may be up to 80 characters long, the file name 60 
characters long.
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Starting HTTP download (example: access mode VTU-R, already active)

Connecting the service.

The profile shown in the display (in this example profile 1) is used for HTTP download.

If no connection is established, the ARGUS automatically connects at this point using the 
default profile (see page 40).

 

<Edit> Adds a virtual line to the service Data.

 
Select HTTP download.
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<Profile>

Mark the server profile:
(default is indicated with ). 
 
The server profiles are also used for HTTP upload, FTP download and FTP upload.

<Edit>

 

HTTP download starts automatically.

You can observe the running test in the test overview. You can access the long-term view 
(see images at right) via “Details”.

Displays the available HTTP download profiles (see image 
at left).

Edits the marked profile, changes the individual settings.
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<New>

<Stop>

Display during HTTP download::

Test overview display:
You can observe the running test or start a new test here, see page 155.

Save HTTP download result, see page 91. 

- Current download/total number of downloads.

- Status

- Current net average download rate 

- Current net average download rate 

- Bytes transferred so far 

- Size of downloaded file 

- Data transferred so far 

- Total data transferred 

- Transfer time so far in h:min:s 

- Remaining transfer time in h:min:s 

- Number of parallel downloads 

- Destination URL

- IP version and IP address used

Selects a new single test.

Stops the HTTP download test.
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11.8 FTP download

In FTP download, the ARGUS downloads data in the form of a file. The ARGUS displays 
the current net download rate, the usable data of the IP packets, and following conclusion 
of the test the average speed (for multiple download attempts).

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the download file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, the ARGUS does not display any data rate or time.

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28. See HTTP download for an explanation of the test parameters.

Starting FTP download
The service Data is started in the same way as for HTTP upload.

Mark the server profile (default is indicated with ). 
 
The server profiles are also used for HTTP download, HTTP upload and FTP upload.
 

 
Select FTP download

<Profile> Displays the available FTP download profiles.
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FTP download starts automatically.
 

You can observe the running test in the test overview. You can access the long-term view 
(see images at right) via “Details”.
Display during FTP download:

<Edit> Edits the marked profile, changes the individual settings.

- Current download/total number of downloads

- Files already transferred (current/overall)

- Current net download rate 

- Average download rate

- Currently transferred bytes 

- Total file size to transfer 

- Data transferred in test (current and total)
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For saving results, see IP ping, page 91. 

- Total data transferred 

- Current download time in h:min:s

- Remaining transfer time 

- Number of parallel downloads 

<New> Select a new single test.
<Stop> Stop the FTP download test.
<Detail> Open the long-term view.
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11.9 FTP upload

In FTP upload, the ARGUS sends the data of a file to a server. The ARGUS displays the 
current net upload rate, the usable data of the IP packets, and following conclusion of test, 
the average net speed (for multiple download attempts).

No meaningful evaluations are possible for upload tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, the ARGUS does not display any data rate or time.

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28. See HTTP download for an explanation of the test parameters.

Starting FTP upload
The service Data is started in the same way as for HTTP upload.

Mark the server profile (default is indicated with   ). 
The server profiles are also used for HTTP download, HTTP upload and FTP download.

FTP upload starts automatically.

 
Select FTP upload

<Profile> Displays the available FTP upload profiles.

<Edit> Edits the marked profile, changes the individual settings.
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You can observe the running test in the test overview. You can access the long-term view 
(see images at right) via “Details”.

Display during FTP upload:

- Current upload

- Data already transferred (current/total) 

- Current net upload rate 

- Average net upload rate 

- Currently transferred bytes

- Total file size 

- Data transferred 

- Total data to be transferred
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For saving results, see IP ping, page 91. 

- Current upload time in h:min:s 

- Remaining transfer time 

<New> Selects a new single test.
<Stop> Stops the HTTP upload test.
<Detail> Opens the long-term view.
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11.10 FTP server

In FTP server mode, the ARGUS behaves like a server for FTP requests. In this mode, the 
ARGUS serves FTP download and FTP upload requests.
These requests can be sent from a second terminal device (e.g. another ARGUS unit) via 
an xDSL or Ethernet access.
This makes it possible to test end-to-end throughput and determine the maximum possible 
data rate for this access.

In the following, the throughput test is explained using the Ethernet interface as an exam-
ple. This example uses two ARGUS units: one as the FTP, one to send the FTP download 
request.  
 
ARGUS 1 - FTP server
 
No settings need to be configured on the ARGUS used as the FTP server. The FTP server 
test just needs to be started on the selected interface.
 
Starting FTP server (example: Ethernet, already active)
The service Data is started in the same way as for HTTP upload.

The ARGUS uses the IP address configured under "own IP address" as the destination 
address (server) for the second ARGUS unit.

ARGUS 1 now waits for an FTP request from a second terminal device (in this example the 
2nd ARGUS instrument). 
The IP mode in this example is "static", the default IP netmask configuration is used.
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ARGUS 2 - FTP down/upload
 
In principle, you can adopt the same configuration for the ARGUS unit sending the FTP 
request (FTP download in this example) as in an FTP download test.
The netmask and IP address (IP mode: static) should match the settings on ARGUS 1.

Starting FTP download:
The service Data is started in the same way as for HTTP upload.

<Profile>

Mark the server profile (default is indicated with ). 
The server profiles are also used for HTTP download, HTTP upload and FTP download.

 
Select FTP download

Displays the available FTP download profiles.

<Edit> Edits the marked profile, changes the individual settings.
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Only enter the address of ARGUS 1 in the server profile of ARGUS 2 as the server IP 
address.

In this case too, the download file name is the size of file to be downloaded.

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10  
seconds, the ARGUS does not display any data rate or time.

See page 111 for displaying the FTP download result during the FTP download.

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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11.11 Web browser

The web browser can display HTML web pages.

Protocol-independent parameters:
Opening of test parameters is described in the chapter "Configuring accesses", see 
page 28.

Starting the web browser

The service Data is started in the same way as for HTTP upload.

Select the URL.
You can configure up to 20 URLs; see “Access name”, page 31 for instructions.

If no connection is established, ARGUS automatically connects at this point (see page 40). 

<Setting> The address can be entered as either an IP number or a name 
(URL).
Default: www.argus.info

 
Select the web browser.
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The selected website opens (see image at left). You can view the destination URL in the 
test overview.

Saving web browser result see also IP ping (see page 91). 

<New> Selects a new single test.
<Stop> Cancels the web browser.
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12 VoIP tests

The ARGUS operates as a VoIP terminal device with active acoustics, enabling voice links. 
Session Initiation Protocol (SIP) is available as a VoIP signalling protocol. Calls can be 
established both with and without registrar/proxy. The ARGUS can be used to establish 
VoIP connections (DSL telephony) via xDSL, G.fast and Ethernet. To assess voice quality, 
the ARGUS determines and displays the MOS/R-factor and the RTP datastream.

You can configure ten VoIP "accounts" (profiles):

Protocol-independent parameters:

The ARGUS status screen (see image at left).

<Edit> Assigns a virtual line to the service VoIP.
<Profile> Profile settings, see page 33.
<Start> Activates the service.

Select the profile you wish to edit (see image at right). The selected profile appears 
in the display in blue. The default profile is indicated with a  in the display. The 
ARGUS adopts the parameters from the default profiles for establishing the 
Ethernet, G.fast or xDSL connection and conducting the VoIP test. 

The ARGUS uses the marked profile as the preset profile and switches to the menu 
Settings. 
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The "Edit" softkey takes you to the Service VoIP menu (see picture on the left). Once you 
have selected the option VoIP account, you can edit the VoIP profiles (see image at right). 
A total of ten user-defined VoIP profiles are available. 

<Edit>

 

 
You first need to decide whether you want to configure this using the wizard or manually.  

The following test parameters can be configured for the VoIP account:

- VoIP

  - Provider Assistant

- Manual Configuration

  - SIP

    - User name

    - Password

    - Authentication

    - Caller ID

Edits the VoIP profile (see image at left).

The wizard only prompts for a subset of all configuration settings. 
122 ARGUS 300



12 VoIP tests
    - Registrar Server

    - Outbound Proxy / SBS

    - DNS resolution

    - SIP trunk

      - Trunk used

      - CLIR

      - own trunk number

      - own direct dial-in (DDI)

    - Transport protocol

    - SIP domain

    - Listen port

    - Remote port

    - User agent

    - Qualify

    - Reg. expire

    - Retry-after

    - Delete current registration

  - Telephone setup

    - RTP port range

    - Silence detection

    - Jitter buffer

    - Codecs

    - DTMF settings

  - STUN server

    - STUN used

    - STUN server

  - Rated / threshold values

    - MOS rated value

    - Jitter threshold

    - RTP loss threshold

  - Profile name
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You can configure the following settings for VoIP QoS (quality of service):

- Layer 3 DiffServ

  - RTP (ToS/DSCP)

  - SIP (ToS/DSCP)

- Layer 2 VLAN Prio

  - RTP VLAN Prio

  - SIP VLAN Prio

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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12.1 Starting VoIP telephony

(Example: VDSL access, already active)

Connecting the service.

The profile selected for xDSL connection is also used for VoIP telephony.

<Edit>

If no xDSL or Ethernet connection is established, the ARGUS automatically connects at 
this point using the default profile (see page 40).

<Info>

<Test>

<Stop>

Edits the default virtual line profile.

The service VoIP is greyed out when the VoIP option is not set.

Duration of activation, see page 129.

Opens test selection.

Deactivates the service.
ARGUS 300 125



12 VoIP tests
Marks the VoIP destination
(default is indicated with  ). 
 
Scroll down with the cursor, mark a blank line and add a new VoIP destination using  
<Edit>. 

Connecting.

The ARGUS displays its "own number" (from: 7089) and the number of the called 
subscriber (to: 89). The called subscriber has not yet accepted the call: call info 
“Connected” and yellow telephone handset symbol. 

 
Select VoIP call.

<Edit> Edits the VoIP number.
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The called subscriber has accepted the call (status “OK” and green check mark). The 
ARGUS determines the MOS value and displays whether the voice quality attains the 
target MOS voice quality value (see page 216) ("OK" or "FAIL"). The ARGUS also displays 
the classification of the MOS value according to ITU-T P.800 (in this example "good"). The 
duration of the call and the currently used voice codec (in this example G.711 A-law) are 
additionally displayed along with the RTP loss rate.

See page 206 for the meanings of the symbols displayed. 
 

VoIP overview display (for transmitted and received packets including assessment)

-
-
- 
- 
- 
-

Status
MOS value  (FAR-MOS/MOS) 
Jitter in ms
RTP loss rate
VLAN (Prio) in hexadecimal
TOS (hex) in hexadecimal

The FAR-MOS value is only displayed when the remote station supports 
RTCP.

<Detail> Displays the VoIP parameters
<Volume> Opens the volume control
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Display of further VoIP results: 

RTCP content
Displays the statistics returned by the remote station.
- Current jitter of remote station Rx (far)
- Average jitter at remote station
- Maximum and minimum jitter of remote station
- Lost RTP packets at remote station
   Rx (far): Total, current, average, min. and max.

Display of MOS info (for transmitted and received packets):

- 
- 
- 
-

Current MOS
Average MOS
Min./max. MOS value
Ideal MOS (possible MOS without interference, codec-dependent)

Packet statistics:

- 
- 
- 
 
 
- 
 
 
 
 
- 

Received packets (Rx)
Transmitted packets (Tx)
Error counter: 
RTP drop 
RTP error
RTP jitter Rx:
Current jitter
Average jitter 
Minimum jitter 
Maximum jitter
Lost RTP packets (Rx)
Current, average, min. and max., total
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- Network delay calculated from the transmission time of RTCP packets: current, average, 
min. and max.

The ARGUS displays the available codecs of the remote station.

When you select “Info” in the status screen, the ARGUS displays the duration of the active 
VoIP service, the protocol used and the user name.

If the message "no data" appears, that means that the remote station does not 
support RTCP.

Display of QoS info (for transmitted and received packets including assessment)

- 
- 
- 
- 
-

VLAN ID
VLAN Prio RTP
VLAN Prio SIP
RTP ToS in hexadecimal
SIP ToS in hexadecimal

<SIP> Displays registration details: status codes, registrar IP, registrar used, outbound 
proxy/SBC and URI used and more.

<Log.> Displays the VoIP service SIP commands, see page 130.
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Before, during and after the connection, the ARGUS displays the registration details. The 
setting "Use registrar" must be set to "yes” (see image at left).

The ARGUS displays the SIP commands in the service VoIP (see image at right). A 
timestamp is added for all events.

For further information, see page 212 “Software licenses”.

The timestamp is generated using the ARGUS-internal system time.
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The ARGUS can be called while the service VoIP is active. An incoming call is indicated by 
the yellow CALL symbol. The call can be accepted or refused.
For automatic call acceptance, you need to start the specific test "VoIP call acceptance", 
see page 133.

VoIP results 

<Refuse> Refuses the call. Switches to status screen.
<Accept> Accepts the call. Switches to ARGUS status.

You can obtain further information on the VoIP results in the ARGUSpedia on 
the instrument.

Incoming call:
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12.1.1 VoIP back-to-back

The ARGUS permits a VoIP call to a second terminal device, e.g. another ARGUS unit.  
To enable calling, both ARGUS instruments must be configured as follows:

Now enter the IP address of ARGUS 2 in ARGUS 1 as the target telephone number to initi-
ate a VoIP call. The IP address of ARGUS 1 must be entered as the target telephone num-
ber in ARGUS 2.

The call is connected just as for VoIP call/VoIP call acceptance, see page 133.

ARGUS 1 ARGUS 2

Access, see page 28 Ethernet IP-based

Protocol IP

IP version IPv4

IP mode Static IP

Own IP address In this example 10.0.0.1 In this example 10.0.0.2

ARGUS 1 ARGUS 2
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12.2 VoIP Call Acceptance

In the test "VoIP Call Acceptance", the ARGUS behaves like a VoIP telephone.
The VoIP call (see page 126) and the VoIP call acceptance parameters must be configured 
for the VoIP call acceptance test: 

Connecting the service.

The profile selected for connection (in this example profile 1) is also used for VoIP call 
acceptance.

<Edit>

If no xDSL, G.fast or Ethernet connection is established, the ARGUS automatically con-
nects at this point using the default profile (see page 40). 

<Setting>

Edits the default virtual line profile.

 

Select VoIP Call Acceptance.

Opens call acceptance mode for VoIP Call Acceptance.
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The test VoIP wait offers the following configuration options (see image bottom left):

- Automatic

- Echo test

Default: Automatic

The ARGUS waits for a VoIP call (see image left).

<Detail> Opens further information (see image right).

The ARGUS uses the own number entered under SIP parameters (see 
page 130) as its own number.
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12 VoIP tests
The ARGUS waiting for a VoIP call (see image at left).

The ARGUS automatically accepts the call (see Setting page 134) (see image at right). The 
connection parameters are the same as for VoIP call and are explained on page 126 and 
following.

Disconnecting:
 

The connection is terminated as for IP ping. 

However, pressing "Cancel" initially only disconnects (if a connection existed). 
The ARGUS remains registered with the registrar (service VoIP active) and 
remains available for the caller (an incoming call can be refused or accepted). 
Deactivate the service VoIP to terminate registration. However, the established 
access remains active.
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12.3 VoIP call generator

(Example: VDSL access, already active)

The profile selected for connection (in this example PPP VLAN 7/8) is also used for the 
VoIP call generator.

<Edit>

 

If no xDSL, G.fast or Ethernet connection is established, the ARGUS automatically con-

nects at this point using the default profile (see page 40).
<Info>

<Test>

<Stop>

Edits the default virtual line profile.

The service VoIP is greyed out when the VoIP option is not set.

Duration of activation, see page 129. 

Opens test selection.

Deactivates the service.
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12 VoIP tests
Marks the VoIP destination
(default is indicated with  ). 
 
Scroll down with the cursor, mark a blank line and add a new VoIP destination using 
<Edit>.

Up to 30 consecutive VoIP calls to a configured VoIP destination are established. The 
connection is maintained until the test is stopped.
As soon as a call is refused, the ARGUS stops establishing further calls. Existing calls 
remain connected. If the remote station hangs up a call, this is indicated for that call. The 
test remains active until you press the “Stop” softkey – even if the remote station has 
terminated all calls.

The number of successful calls is displayed. These are the calls that were still connected 
when the test was stopped. Calls that were refused or terminated by the remote station are 
not displayed.

 
 Selects VoIP call generator

<Edit> Edits the VoIP number.

<Stop> Closes the call generator.

<Restart> Restarts the VoIP call generator.
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13 IPTV tests 

13.1 IPTV

The ARGUS requests a data stream from a server (depending on the access type, the 
ARGUS replaces the set-top box (STB) or modem plus STB) and checks the regularity of 
the incoming packets, packet loss and the switch-on/switch-over time of the program. You 
can configure three user-defined IPTV profiles (where the xDSL, G.fast or Ethernet 
connection is already established, the connection parameters, e.g. the target value, are 
locked):

Protocol-independent parameters:

The IPTV-STB emulation is realised using the service IPTV.
The following example illustrates the procedure and its special features.
 
<Edit> Assigns virtual lines to the service IPTV. 

<Profile> Profile settings, see page 33.
<Start> Activates the service.

Select the profile you wish to edit. The selected profile appears in the display in 
blue. The default profile is indicated with a  in the display. The ARGUS adopts the 
parameters from the default profiles for establishing the Ethernet, G.fast or xDSL 
connection and conducting the IPTV test.

The ARGUS uses the marked profile as the preset profile and switches to the menu  
setting.
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13 IPTV tests
Press the softkey “Edit” to configure the VL profile, then start the service IPTV.

Now you can select a single test, e.g. IPTV. A total of three user-defined IPTV profiles are 
available (see image at right). You can edit and modify the marked parameters. 
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You can configure the following settings for IPTV:
- Channel selection
  - Multicast address
  - Port
  - Broadcaster name
- IP version
- limit values
  - IGMP latency
  - Sync error
  - PCR jitter
  - Error indication
  - CC error
  - CC error rate
  - Audio bytes
  - Video bytes
  - RTP jitter
  - RTP sequence error
  - Current RTP loss rate 
  - Total RTP loss rate
- Profile name

You can configure the following settings for IPTV QoS (quality of service):
- Layer 3 DiffServ
  - RTP (ToS/DSCP)
- Layer 2 VLAN Prio
  - VLAN Prio

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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13.1.1 Multiple virtual lines

The ARGUS can use up to 4 virtual lines for the service IPTV. The IGMP virtual lines are 
used for transmission of the IGMP protocol and virtual lines 1-3 for receiving the video/
audio streams. 

Adds selected VL profile for the service IPTV.

<Edit> Edits the selected virt. profile (in this example virt. profile 1).
<More VLs> Opens virtual line selection for the service IPTV.

<Insert> Inserts further virtual profiles.
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<Insert> Inserts a further virtual profile.
<Edit> Edits the selected virtual profile (in this example profile 3).
<More> Opens further selection options.
<Delete> Deletes the selected virtual profile (in this example profile 3).
<> The marked profile is moved down one place in the list.
<> The marked profile is moved up one place in the list.
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13 IPTV tests
Starting IPTV

Connecting the service.

The profile selected for xDSL connection is also used for IPTV.
 

If no xDSL connection is established, the ARGUS automatically connects at this point using 
the default profile (see page 40). 

<Edit> Assigns a virtual line is assigned to the service IPTV or edits it.

<Info> Activation duration
<Test> Opens test selection
<Stop> Deactivates the service

<Profile> Displays the IPTV profiles, see page 147.
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During the test, the ARGUS displays the selected IPTV channel, the duration of the test 
and the current bitrate. If the set limits are exceeded, the IPTV test shows "FAIL" in the 
display, otherwise "OK".
The ARGUS displays "FAIL" until the values fall below the threshold again.

Display:

 

<Channel> Selects a new channel.
<Test 
status>

Displays test status without ending the test or starting a new test, see 
page 155.

<Total> Displays all IPTV statistics.

Cancels test.

- Current bitrate
- Number of packets lost during the test
- Display of packet loss rate in percent
- Display of delay (current, minimum, maximum, average)
- Display of media loss rate

The IPTV test runs until a new channel is selected.

<OK/FAIL> OK/FAIL overview of the IPTV test..

IPTV test
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13 IPTV tests
Display:

IPTV-Ergebnisse

- Current loss rate in %
- Total loss rate in %
- Sequence errors
- RTP jitter
- Latency (in ms)
- Audio bytes (in Byte)
- Video bytes (in Byte)
- Sync error
- Error indication
- PCR jitter (in ms)
- CC errors
- CC error rate (in %)

You can obtain further information on IPTV results in the ARGUSpedia on the 
instrument.
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13.2 IPTV Zapping Test

<Edit>

<Profile>

<Start>

The ARGUS checks the availability of TV channels. Additionally, the ARGUS displays the 
switchover time between TV channels. 
You can create three user-defined scan profiles. The following settings must be saved in 
the profile for the IPTV zapping test (when the xDSL, G.fast or Ethernet connection is 
already established, the connection parameters, e.g. target value, are locked): 
 
Protocol-independent parameters:

Assigns virtual lines to the service IPTV.

Profile settings, see page 33.

Starts the service.

Select the profile you wish to edit. The selected profile appears in the display in 
blue. The default profile is indicated with a  in the display. The ARGUS adopts 
the parameters from the default profiles for establishing the Ethernet, G.fast or 
xDSL connection and conducting the IPTV scan.

The ARGUS uses the marked profile as the preset profile and switches to the 
menu setting.
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A total of three user-defined zapping profiles are available.

<Edit>

In the channel selection menu, the ARGUS initially displays the TV channels already 
selected in the set order that was tested for the IPTV zapping test. If no channels have 
been selected yet, the list is empty. 

The list slots can be filled one after another. You can select up to 250 channels.

Edits the marked zapping profile.

<Insert> Opens the channel list with the available channels.

Marks the channel
Channels already selected do not appear in the channel list (see image 
at right).

<Edit> Edits the marked channel:
- Enter the address (multicast IP and port number) of the TV channel.
- Enter any alias name for the TV channel (e.g. name of broadcaster).
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Add the marked TV channel (in this example 3sat), then add the next channel. If at least 
two channels have been added to the list, you can change their position in the list using the 
following softkeys: 

<Delete>

<Insert>

<>

<>

Deletes the marked TV channel from the selection list. 

Opens the channel list with the available channels.

Moves the marked channel down one place in the list. 

Moves the marked channel up one place in the list.
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13 IPTV tests
Starting the IPTV zapping test

Connecting the service.

The profile selected for xDSL connection is also used for IPTV..

<Edit>

 

Activating the service IPTV.

If no xDSL connection is established, the ARGUS automatically connects at this point using 
the default profile (see page 40). 

<Info>

<Test>

<Stop>

<Profile>

Assigns a virtual line to the service IPTV or edits it.

Duration of activation

Opens test selection

Deactivates the service

Displays the IPTV zapping test profiles, see page 147.
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13 IPTV tests
The IPTV zapping test starts automatically.

Displays the time needed to switch between channels. If a TV channel cannot be received 
within the set interval, the ARGUS displays "Failed".

<Test 
status>

 

 
For saving results, see IP ping, page 91. 

Displays test status without ending the test or starting a new test, see 
page 155.
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13.3 IPTV Monitor

ARGUS checks for transmitted TV channels without requesting a channel. ARGUS lists the 
TV channels it detects in a list of multicast IPs and/or channel names.

 
A second ARGUS in STB mode can be connected in place of a PC or STB. 

 
 

 

 
 
 
 

Patch cablexDSL line

Socket LAN 1 / SFP 1Socket Line

Ethernet xDSL , G.fast

G.fast or 
xDSL access

PC with VLC 
(video LAN 
client)

Set-top box  
(STB)

alternatively

passive

passive 

active 

Ethernet 
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Starting IPTV Monitor

Aufbau des Services. 
 
Connecting the service. 
 
The profile shown in the display is used for the IPTV Monitor.
 

Use the cursor to select the router and start it. 
 
Router mode is started (see picture on the right).
 

 
Use the cursor to select and activate the IPTV service.

IPTV Monitor can also be run in bridge mode. However, the bridge must be 
activated first. 

<Info> The duration of router activity is displayed. 

<Stop> Stops router mode. 
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13 IPTV tests
 
The service IPTV and the router mode are active and the VDSL access is synchronous.

 

Marks the IPTV profile 
(default is indicated with   ). 
 

 

To access the softkey <Test> in bridge mode, switch to the bridge box and 
activate it.
The services are not available in bridge mode. 

<Profile> Displays the IPTV Monitor settings.

<Edit> Edits the marked profile, changing of individual parameters. 
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13 IPTV tests
ARGUS automatically checks whether IPTV streams are available and displays these. 

 

 
In this example, one possible stream is displayed.

<Refresh> Updates the channel list.
<Test  
status>

Displays test status without ending the test or starting a new test.

<IP> Displays the multicast IP of the selected channel. 
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14 Parallel tests

The ARGUS permits parallel testing of different IP-based services (data, VoIP, IPTV and 
opt.) running on xDSL, G.fast or Ethernet interfaces. The settings for each test are 
described in the respective chapters.

The following tests can be run in parallel. Any combination of the tests listed here is possi-
ble. Up to ten tests can be conducted concurrently.

Service Test Remark

Data

IP Ping*1, see page 85

For these tests, up to 10 tests can be 
conducted concurrently (incl. tests 
using the other services). 

Traceroute*1, see page 93

Path MTU, see page 96

iperf Client, see page 98

iperf Server, see page 101

ARGUS® Real Speed (RFC 6349), 
see page 103

Speedtest® by Ookla®

HTTP download, see page 105

FTP download, see page 110

FTP upload, see page 113

FTP server, see page 116 See remark for VoIP

Web browser, see page 119

VoIP

VoIP call, see page 126 These tests can be combined with 
any other test. Please note that a total 
of ten simultaneous VoIP connections 
are possible.

VoIP call acceptance, see 
page 133

VoIP call generator, see page 136

IPTV

IPTV, see page 138 These tests can be combined with 
any other test. Note that only one 
IPTV test can be active at any time.IPTV zapping test, see page 146

IPTV monitor, see page 151
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Opt.

IP Ping*1, see page 85

For these tests, up to 10 tests can be 
conducted concurrently (incl. tests 
using the other services).

Traceroute*1, see page 93

Path MTU, see page 96

iperf Client, see page 98

iperf Server, see page 101

ARGUS® Real Speed (RFC 6349), 
see page 103

Speedtest® by Ookla®

HTTP download, see page 105

FTP download, see page 110

FTP upload, see page 113

FTP server, see page 116 See remark for VoIP.

Web browser, see page 119

*1 Also possible via the services VoIP and IPTV
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The possibility of parallel testing is illustrated using HTTP download and VoIP via the ser-
vices Data and VoIP. Display and operation for further parallel tests, e.g. IPTV, is performed 
in the same way as for Data and VoIP.

ARGUS status screen.

The VDSL VTU-R access shown in the example and the services Data and VoIP are active.

<Info>

<Test>

<Stop>

<Profile>

Duration of activation.

Opens test selection.

Deactivates the service.

 
Select e.g. HTTP download.

Displays the available HTTP download profiles.
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14 Parallel tests
Mark the server profile:
(default is indicated with ). 

HTTP download starts automatically. 

Display during HTTP download and test status: see “HTTP download” on page 105.

<Edit> Edits the marked profile, changes the individual parameters.

 
Select further test, e.g. VoIP call.
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14 Parallel tests
The ARGUS executes an HTTP download and a VoIP call in parallel.

The VoIP call is stopped (see image at right).

 When more than one test is executed, you can select the tests with the left 
and right cursor keys or by tapping the touchscreen.
For more than six tests, the test rows expand downwards.

<New> Selects a new single test.
<Stop> Stops the test, in this example VoIP call. Depending on the test, you can 

subsequently re-initialise it with <New>. The configuration remains 
unchanged.

>Details> More information on the selected test.
<Finish> Deletes the selected test. Prior to this action, tests can be saved.
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15 Fiber

ARGUS enables a variety of tests at optical fiber interfaces (using the optical power meter 
and optical fault finder, among other tools). 

15.1 Optical Power Meter

An optical power meter measures the optical performance of optical fibres (e.g. GPON) at 
various wavelengths. The power level is displayed live and can be stored in the device as a 
measurement protocol and QR code.

Select new fiber access and then “Optical Power Meter”. You can now select either the 
USB or SFP1 interface.

In this example, the ARGUS® Optical Power Meter in SFP form factor is used.
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15 Fiber
The measurement starts as soon as the optical power meter is selected in the Access 
menu.
You can set different wavelengths using the arrow keys.

The Power Meter measures from -60 to +6 dBm the light power of different 
wavelengths in a range from 850 to 1625 nm.
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15.2 Optical Fault Finder

The Optical Fault Finder lets you simply and rapidly detect optical faults, including clear text 
and distance indication. Only reflective events are measured. Up to 15 events can be 
detected in one test.

Select new fiber access and then “Optical Fault Finder”. Then select interface SFP1.

The test starts automatically when you select the access “Optical Fault Finder”. The results 
are shown together with the corresponding distance.
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15 Fiber
During detection, a dead zone of ≥ 30 m and an absolute accuracy of ≥ ± 50 m 
must be strictly observed.
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15.3 Fiber Inspection Tool

The Fiber Inspection Tool (FIT) is a USB video microscope for optical fiber inspection that 
detects scratches and defects on optical fibers. 

Select new fiber access and then Fiber Inspection Tool. Now select the connector type 
(here SM PC RL >= 45 dB).

If the Fiber Inspection tool is now selected in the access menu, the measurement starts 
immediately. The current video image is automatically analyzed and the number of defects 
and scratches is displayed in an overview table sorted by zones (core, cladding, adhesive, 
contact).
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15 Fiber
<Details> Detailed display of defects and scratches (see image on the right).

Pass/fail evaluation is performed according to IEC 61300-3-35. The minimum 
particle size is 0.5 µm.

There are different adapters (tips) available for PC, UPC, APC and more, ask 
our support.
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16 Operation on a POTS access
16 Operation on a POTS access

 

The voltages on the subscriber line may not exceed 130 VDC and should be free 
of AC voltage.

16.1 Setting the POTS Interface

Use the included connection cable to connect the ARGUS (Line jack) to the POTS access 
to be tested. The setting of the connection type is explained in the chapter Configuring 
accesses, see page 28. In this example the POTS TE mode was selected.

The following settings can be made for POTS:
- Dial Mode
- Clip Mode
- DTMF Parameters
  - Level
  - Time
  - Interval
  - Default settings
- Flash-Time

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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16.2 Connection on a POTS access

Outgoing Calls

The ARGUS sets up a connection to another terminal. If the terminal at the other end is a 
telephone, the handset integrated in the ARGUS or a headset can be used to hold a 
conversation. 

Incoming Call 

The ARGUS signals an incoming call both audibly and on the display (see picture on the 
right). 

If the access supports CLIP, the ARGUS will display the number of the caller.

<Volume> Volume setting.

<R> Generating a FLASH signal.

<Call Number> The ARGUS displays the last number dialed (redial) or that of 
the last caller. 

<Accept> or Establishing a connection: Enter the phone number via the 
keypad. Each digit of the number is dialed individually. The 
ARGUS will display the dialed number. As soon as the remote 
party accepts the call, a speech connection is established. 
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16 Operation on a POTS access
<Accept> or Accept call.

The call number received will be saved in the “Last caller” 
memory location. 
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17 Operation on an ISDN Access

 

The voltages on the subscriber line may not exceed 48 V (BRI S/T) and should be 
free of AC voltage. 

17.1 Setting the ISDN Interface and Access Mode 

<Setting>

<Access>

<Termination on>

<Start>

Connect the supplied connection cable (BRI S/T) to the ARGUS "Line" socket and your test 
connection. 
Opening the test parameters is described in the chapter Configuring accesses (page 28).  
In this example the ISDN TE mode was selected. 

After selecting "Test" one of the shown connections can be selected (see picture on the 
right).

The following settings can be made for BRI S/T:
- L1 permanent?
- Alerting mode
- BRI termination

Open the "ISDN BRI S/T settings" menu.

Switch to the connection menu.

Switch the termination on or off.

Repeat the B channel test.
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17 Operation on an ISDN Access
17.2 Initialization phase followed by a B channel Test 

Initialization on a BRI S/T access  

The ARGUS will begin the initialization after taking over the existing, confirmed settings or 
new settings for the type of access and mode. Next the ARGUS will setup Layer 1. While it 
is setting up Layer 1, the "Sync 1" LED above the display will blink. If the ARGUS cannot 
setup Layer 1, it will display the message “No net”. As soon as Layer 1 is successfully 
setup, the "Sync 1" LED will light continuously. 

If everything has been detected without errors, the ARGUS will display the type and mode 
of access found. Additionally, a qualitative assessment of the level will be displayed.

The ARGUS will automatically determine the protocol (in both TE and NT mode) or use the 
protocol set manually (see page 19 protocol). On a bilingual access, the ARGUS will use 
the DSS1 protocol.

The "Protocol" LED will light after the ARGUS has set up Layer 3. At the same time the 
ARGUS will start a B channel test and then display the results. If an error occurs in the B 
channel test (e.g. access is not plugged-in), the ARGUS will display an error message. 

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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17.3 Service check

The ARGUS checks, which of the following services are supported by the access under 
test:

The test runs automatically. The ARGUS will make a separate self call to test each of the 
user-specific services. However, the call will not be answered.
Enter the own (local) number of the access under test or select it from the speed-dialling 
memory. 
The ARGUS suggests the B channel used last. If you enter an "*", the ARGUS will choose 
any B channel that is free. 

There are PBXs that use separate call numbers for incoming and outgoing calls. 
In this case, for the Service tests, you can enter a “remote” call number that does 
not match the “own” number that is stored in the ARGUS. If the Service check 
should extend outside of the local exchange, it is possible to perform the Service 
check in an end-to-end mode. In this case, you must enter the remote call 
number for a second terminal device. The ARGUS will then automatically check 
whether the remote terminal can accept the call under the various services – in 
other words, whether it is “compatible” with these services. 
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17 Operation on an ISDN Access
Overlap sending (outgoing call)  

In overlap sending, the digits entered for the call number are sent individually. 

Enter phone number via keypad.

press  

press   
again

 
En-bloc sending (outgoing call)   

In en-bloc sending, the ARGUS sends the entire dialling information in one block.  

Redialling (outgoing call) + Last caller (incoming call)  
 
The ARGUS will set up a call using the last number dialled or the number of the last caller. 

Simplified individual dialing via the telephone key 

The ARGUS will go directly to the Connection/Single Dial window 
regardless of the menu that is currently open. 

The exchange tone sounds, after entering the phone number the 
connection is established. 
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18 Operation on a PRI Access

18.1 Configuring the PRI Interface and Access Mode Settings  

Use the included connection cable to connect the ARGUS "PRI/EI" jack to the access to be 
tested. In this example the PRI TE mode was selected. 

<Setting>

<Access>

<L1 status>

<Start>

The following settings can be made for PRI:
- Alerting mode
- PRI termination
- Sensitivity
- Sa5 bits
- Sa6 bits
- A-Bit
- CRC4 mode

Switch to the "PRI setting" menu.

Switch to the connection menu.

Open L1 status.

Start B-channel test.

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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18.2 Initialization Phase including B-Channel Test  

Initialization on a PRI network 

As soon as Layer 1 is setup, the "Sync 1" LED will light continuously. The ARGUS will 
automatically determine and display, whether or not the PRI access uses CRC4- 
monitoring. CRC4 monitoring can be switched on or off manually.

The ARGUS will begin to automatically determine the access configuration. After Layer 2 is 
set up, the “Protocol” LED will also light. The ARGUS will, regardless of the mode of 
operation (TE or NT mode), determine the D-channel protocol and attempt to set up Layer 
3. 

During this phase, the ARGUS displays the A bit of the remote side and the FAS. The 
protocol can only be determined when the A bit is not set. The FAS (Frame Alignment 
Signal) indicates whether the ARGUS could correctly synchronize with the incoming 2 Mbit 
data stream’s alternating frame identification word or message word and the, perhaps 
present, CRC4-superframe structure. 

Press the <Start> softkey to have the ARGUS begin to test the availability of all 30 B-
channels one after the other by occupie the B-channels. If the ARGUS can place a call on a 
B-channel, it will be assumed that the B-channel is available in both directions; the B-
channel test cannot distinguish between alternating and exclusively "outgoing" B-channels. 
If the connection is rejected, the B-channel will be identified as unavailable. In the case of a 
cause, which indicates that the B-channel is occupied, the connection will be tried up to two 
times and, if a connection can still not be setup, it will then be marked as unavailable. 
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18.3 The L1 Status of a PRI Access  

The ARGUS displays the Layer 1 alarms and messages, which provide detailed 
information regarding the state of the PRI access and the transmission line (For further 
information, see the CCITT/ITU guidelines G.703 and G.704). 

<x> The PRI relay for the Rx/Tx pin assignment will be toggled to its other 
position, regardless of the state that it was in before. 
This function is only available in the L1 status menu if there is currently 
no signal. The state of the relay will remain unchanged when you close 
the L1 status menu. 
wires = means that Rx/Tx are normal
wires X means that Rx/Tx are inverted 

<Reset> Reset the History function and all counters.

You can obtain further information on display contents in the ARGUSpedia on 
the instrument.
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19 Test results

The saved test results are displayed either in the ARGUS display or on the PC as a 
detailed measurement log. 
 
The ARGUS stores the test results together in 50 definable save slots. The system 
suggests "New result" as the default save name. The saved test results are also deleted 
when all configuration settings are reset.

The test results can be selected in the Quick Menu. By selecting a test result and then 
pressing the confirmation key, the test results are displayed.

<More>

<Sort>

<Rename>

<Select all>

<Delete all>

The "Sort" and "Rename" softkeys are displayed.

Sorting:
- Ascending by name
- Descending by name
- Ascending by date
- Descending by date

Changes the name

Selects all test results

Deletes one or all test results
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19.1 Saving test results

You can save the result after the end of a test or after disconnecting a connection.
The ARGUS saves the test result in the first free slot. If all slots are occupied, you need to 
manually select a slot to overwrite

The ARGUS automatically suggests a save name. The name is made up of:
- Device Type (here A300) 
- Serial number (here 01324) 
- Configured date (here 01 January 2021) 
- Set time (here 09:15) 

You can accept the displayed save name or enter a new one using the number keys. You 
can enter up to 24 characters. The ARGUS displays the number of characters used so far.

<Last name>

Save name: Input see Access name page 31.

19.2 Sending test results to PC

The test results can be sent to the PC for visualization and archiving. Connect the ARGUS 
(ARGUS socket "USB-B") to the interface of your PC using the cable supplied and select 
A300 in the Explorer. The "results" folder now contains the test results that can be opened 
in the browser.

The ARGUS suggests the last save name used. 
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The ARGUS offers WLAN as the management interface for an array of functions.

20.1 Switching on WLAN

After pressing the gear button, you reach the instrument settings. After selecting Remote 
Access, select Management Interface.

Here you can start the management interface and edit the profile. 

For editing the profile, the Management Interfaced must be switched off.

The WLAN interface is now activated. The ARGUS is now in access-point mode (ARGUS-
AP). The WLAN symbol in the status line is green .

You can set up a WLAN connection with the ARGUS by selecting the WLAN access with 
the name “Argus300_SerialNumber” on a smart phone, tablet or laptop and entering the 

Either ETH or WLAN can be selected as the management interface; the default 
setting is WLAN. 
You can change this under “Device settings/Management interface/Interface”.
This is only possible when the management interface is greyed out under “Start/
Management interface”; if WLAN or Interface is greyed out, switch off the 
management interface first.
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password stored in the ARGUS.

Electronic job management applications can also access the ARGUS and pick up 
measurements using WLAN. Ask our Support team about this.

20.2 Test results via WLAN
If for example a laptop has a working WLAN connection with the ARGUS, you can open the 
Web server by entering the IP address of the ARGUS unit or myargus.info in your 
browser’s address bar.

The measurement log with the name data.csv can be opened directly or saved on the lap-
top.
You can also use this functionality to save, delete and rename measurement logs. For this, 
you require a WebDAV application/app on your PC/laptop or smart phone/tablet.

 

The connection data of the last measurement are saved in the .csv file.

The command “VNC” lets you control the ARGUS remotely via your browser.
 
You may first need to activate the VNC server on the ARGUS.

Further information regarding the VNC server is available on request.

The ARGUS Web server has its own SSL certificate (myargus.info), which permits 
https:// access.

You can also access the ARGUS using WebDAV via myargus.info. By this means, 
you can download measurement logs in .amp format directly from the ARGUS via 
Ethernet or WLAN.
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20.3 WLAN in router mode

When the ARGUS WLAN interface is active, it is connected directly with the ARGUS router. 
If you want to use the ARGUS as a true WLAN access point (ARGUS-AP) and e.g. start a 
download with this device as the gateway, you must first start a DSL access (ADSL, VDSL, 
SHDSL, see page 40).

If the router (see diagram) has been started, both WLAN and LAN1 are connected to the 
ARGUS router.

The smart phone, tablet or laptop can use the ARGUS as an access point. All applications 
such as data, VoIP or video that can be run e.g. on a smart phone can now be executed for 
testing via ARGUS - thus replacing all customer devices.

WLAN and LAN are not linked via an Ethernet bridge. Each requires its own con-
figuration. They may not be configured identically.
A test from WLAN to LAN or vice-versa is not possible.
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The ARGUS can be custom-configured for special requirements. The default values are 
restored using "Reset" (see page 192).

21.1 Cloud services

The ARGUS supports cloud services for communicating with its environment. These ser-
vices enable the ARGUS to share data with other systems via its test interface. The 
ARGUS offers test interfaces for ADSL, VDSL, G.fast, SHDSL, Ethernet, GPON and 
WLAN. When connected via these interfaces and with the data service running, the 
ARGUS can download firmware updates, import a configuration and upload measurement 
logs..

The cloud services are deactivated by default.

At a minimum, the data service must be connected and successfully started via a 
VL using the corresponding test interface.

The instrument only checks whether there is a different firmware on the server 
than the one it has loaded. Be aware of this if you have your own update server. 
Downgrades are possible, and can result in a loss of configuration data.

After pressing the gear button, you reach the instrument settings. After selecting the cloud 
services, select e.g. firmware update.

Select the cloud service you wish to configure and open it with   .
You must agree to the privacy policy before use.
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The following cloud service parameters can be configured:
- Firmware update
  - Server
    - FTP Server address
    - User name
    - Password
    - Profile name
  - Check for updates
  - Updating
- Importing configurations
  - Server
    - FTP Server address
    - User name
    - Password
    - Profile name
  - Test
  - Import destination
  - Import
- Upload measurement log
  - Server
    - FTP Server address
    - User name
    - Password
    - Profile name

Three server profiles are offered for server selection. All three profiles are  identi-
cal, and differ only in their profile names:
- Server profile 1: Firmware
- Server profile 2: Configuration
- Server profile 3: Measurement log
You can also assign any name to the server profiles (Profile name) for your use, 
e.g. you can create two different profiles for importing configurations if measure-
ment log uploading is not needed.

Only the server profile “Firmware” is preconfigured. When the server specified in 
this profile is used, the ARGUS always looks for a new firmware version on intec’s 
server. The ARGUS instrument logs onto the server with its serial number and IP 
address. 
 
See page 206 for the meanings of all symbols used in the cloud updates.

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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21.1.1 Cloud update

The cloud update process is explained in the following. In this example, VDSL VTU-R 
mode is configured and selected as described in Chapter 5, “Configuring accesses” (see 
page 28). For details on configuring the firmware updates, see the chapter “ARGUS set-
tings”, page 181.

Never under any circumstances import a configuration when the ARGUS is operat-
ing in battery mode. Connect the ARGUS to the power adapter before importing a 
configuration.

Connecting the service. 

See page 225 for important information on updating your ARGUS firmware.

 

The profile shown in the display (in this example profile 17a) is used for the cloud update.

<Info>

<Stop>

If no connection is established, ARGUS automatically connects at this point (see page 40).

The service Data and the VDSL connection are active. 

Activation duration

Deactivates service
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The blue “FW” in the status line indicates that a firmware update is available. 

The ARGUS automatically restarts after a successful firmware update. 

<Info> Activation duration
<Test> Opens test selection
<Stop> Deactivates the service

 Use the menu key to switch to the Quick menu and start the firmware 
update.
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21.1.2 Automatic configuration import

This function enables you to read out and adopt the ARGUS configuration file.

Never under any circumstances import a configuration when the ARGUS is 
operating in battery mode. Connect the ARGUS to the power adapter before 
importing a configuration.

Prerequisites:

The instrument is connected to the interface (xDSL, G.fast, Ethernet or LTE).

The instrument must connect with the server, and a suitable configuration file for this 
instrument must be available.

If the configuration is not imported immediately, the instrument will display a corresponding 
message each time the instrument is powered up.

In the settings, select "Backup/Restore" and then "Configuration Import".

A new configuration file is available.
ARGUS 300 185



21 ARGUS settings
The configuration file is downloaded.

The instrument needs a few seconds before it can be restarted; this is 
indicated by an hourglass in the top right next to the battery indicator.

<Restart> Restarts device
186 ARGUS 300



21 ARGUS settings
21.1.3 Upload measurement logs 

This function enables you to upload test results to an external server and download them 
again at a later date.

<Order> Sorts test results by name or date (ascending or descending).
<Select all> Selects all test results.
<Delete> Deletes test result.
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21.2 Remote access

The ARGUS offers a wide variety of remote control functions. For instance, it can connect 
to a mobile end-user device (smart phone or tablet) via the WLAN interface, and can be 
remotely controlled from the mobile device. 

The following test parameters can be configured for remote access:
- Management interface
  - Start management interface
  - Select interface
  - WLAN
    - SSID
    - Password
    - Channel
    - DHCP server
  - IP settings
    - IP address
    - Netmask
    - Gateway
- Webserver
  - Start webserver
  - Password protection
- VNC server
  - Start VNC
  - Password protection
  - VNC scaling

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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21.3 Device settings

Changing a device setting is described using the setting "Design" as an example.

After pressing the gear button, you reach the instrument settings. After selecting Device, 
select e.g. Design.

The default is indicated with a  in the display.
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The following device parameters can be configured:
- Operating language
- LCD brightness
- Set date/time
- Ring volume
- Alarm tone
- Power-up tone
- Power-saving mode
- Software option
- Licenses
- Company address

Mark the desired setting. The marked setting is highlighted in blue in the display.

Return to next-higher level menu without saving setting change.

Saves the setting change.

You can obtain further information on settings in the ARGUSpedia on the 
instrument.
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21.4 Backing up and restoring settings

The ARGUS offers multiple functions for backing up and restoring settings. In addition to 
the actual backup/recovery of the settings configured in the ARGUS, these also include the 
options of restoring the factory defaults and importing configurations to overwrite the cur-
rent one.

21.4.1 Backup/restore

With the ARGUS, you can back up all settings (call numbers, PPP user name, PPP 
password, IP addresses, profile names and more) and restore them if needed.

All settings made in the ARGUS are backed up unchanged and can thus be restored later. 

The settings are now backed up and can be restored as necessary. 
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Select "Restore Configuration".

21.4.2 Restoring the factory settings

The ARGUS resets all settings to the factory defaults.

The call numbers, PPP user name, PPP password, IP addresses, profile names 
and all test results stored in the ARGUS are deleted

 
 
 
 
 
 
 
 
 
 
 
 

All parameters are reset to the factory defaults.

Restores the saved test settings.

If no settings have been backed up, this function has the same effect as 
"Restore factory defaults". A security password is not required.

If no settings have been backed up, this function has the same effect as 
"Restore factory defaults".

and
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22 Update via PC

You can download firmware files online free of charge at www.argus.info/service and then 
upload them to the ARGUS.
Go to the web page www.argus.info.
Click the menu option "Service" (highlighted in blue here) in the navigation bar.
.

In the drop-down  
Service menu, click the 
option "Downloads". 

 

This opens up a product overview.
 
 
 
 
 
Select your ARGUS instrument. 
 
 
 
 
 
 
 

Once you select your device, you are automatically taken to the firmware updates.
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The ARGUS 300 functions as a mass storage device and is connected to the PC via a USB 
cable. After downloading the firmware, load it onto your ARGUS 300 using Windows 
Explorer.

Next, select “Firmware update” in the quick menu (illustration at left). Then select ARGUS 
Mass Storage (see image at right).
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When updating the firmware the ARGUS instrument must be charged to at least 50 % 
capacity or connected to a power adapter. You are prompted to confirm the ARGUS 
connecting to the PC as a USB mass storage device (see image at right).

Once the ARGUS is connected to the PC, the firmware file is displayed when you press 
Start. 

The update is now started. This requires a restart of the ARGUS.
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Important information on updating your ARGUS firmware:

- An ARGUS USB cable is required for updating (USB cable with mini-USB 
plug). 

- You should back up the configuration and measurement logs to a PC before 
performing an update.

- Do not switch off the ARGUS during the update. 
- Be sure to observe the messages in the ARGUS display. 
 
If problems occur because of a failure to follow these safety instructions, repeat the 
update process up to three times.  
Each repetition makes it possible to overwrite further faulty software components.
196 ARGUS 300



23 Using the battery pack
23 Using the battery pack

Changing the battery pack
Power down the ARGUS and disconnect the power adapter. Then release the two screws 
securing the battery pack.

Handling the battery pack 
The ARGUS may only be operated using the battery pack supplied with the device; 
connecting other power supply units to the contacts of the device will damage the 
ARGUS.

- Only charge the supplied battery pack in the ARGUS.

- Do not use the ARGUS battery pack in other devices.

- Power adapters from other ARGUS instruments are not compatible with the ARGUS 
300. Attempting to connect the power adapter of another device to the ARGUS 300 
can damage the socket.

- Active charging of the battery pack and automatic charging (on by default) may only 
be carried out in a temperature range of 0 °C to +40 °C.

- Charge the battery pack completely at least once a month (even if the device has not 
been used for a longer period!).

- The lithium ion battery pack should be stored with a charge of 40 to 60 %. When 
storing the device for longer periods, you should refresh this charge level every six 
months. To prevent full discharge, remove the battery pack from the device for long-
term storage. 
To maximise battery life, do not store the battery long-term at temperatures above 
+50 °C.

- See the chapter Safety information (page 9) for detailed information on using and 
transporting the lithium ion battery pack safely.
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Status
The ARGUS indicates the current state of the battery graphically in the display when no 
power adapter is connected. A battery symbol flashes in the display when it is down to a 
power reserve of approx. 8 minutes (depending not the operating mode). Tone errors, and 
in extreme cases malfunctions, can occur in this period. Connect the power adapter. The 
ARGUS can recharge the battery completely when the power adapter is connected. The 
ARGUS power pack does not require manual discharge. A complete charging cycle can 
take up to approx. 6 hours.

When the power adapter is connected, you can view the battery status in the quick menu. 
This displays the voltage, current level, temperature and other parameters during the 
charging process.
 
Automatic battery charging in the background

In the ARGUS Manager, you can toggle “Automatic charging (on)” to “Automatic charging 
(off)” and back by tapping this option. When automatic charging is on, the ARGUS charges 
the battery automatically in the background when the mains adapter is connected as soon 
as the battery status falls below a threshold value (battery symbol in display).
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You can also toggle automatic charging on and off in the quick menu. 

When the ARGUS is disconnected from the power adapter before that battery is 
completely charged, the ARGUS does not automatically continue charging when it 
is subsequently reconnected because the charge is no longer below the threshold.
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24 ARGUSpedia

The ARGUSpedia is an internal help function with lots of information about the device and 
settings. It is an important supplement to this manual.

Select “Open Manual“ in the Quick Menu to open the ARGUSpedia. 

Now you can either navigate via the links in the content menu or search in the Manual or on 
the site that you are actually on by selecting the Softkey „Menu“. 
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After selecting „Search in Manual“, you can enter a search term.

Now you get a list of search results. The search term is highlighted in yellow. In addition, it 
is indicated how many hits there are on the respective pages. 
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After selecting „Search on Site“, you can enter a search term. All results on this page are 
highlighted in yellow.

On many pages, you can jump to specific sections. These sections are shown on the top of 
the page after using the softkey „Content“. Just tap on them or use the cursor keys to jump 
to one of these sections.
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A) Hotkeys

Graphic functions:
After starting the xDSL interface or a test such as line monitor or TDR, you can use the 
following graph functions in the result displays:

Hotkey xDSL Trace ADSL/VDSL,
G.fast Line scope TDR

Name - - -

- Zoom Zoom Zoom

Cursor Cursor Cursor Cursor

- - Measuring 
range

Measuring range

- - Total power Pulse width/
amplitude

- - - Cable type/VoP

- - Probe -

- - Symmetry -

- Setting x-axis Time/FFT -

- Min/max Peak-hold -

- - 100 Ω input 
resistance

-

- Continue - -

- - Start/stop Start/stop

- - Reference curve Reference curve

Number key 1

Number key 2

Number key 3

Number key 4

Number key 5

Number key 6

Number key 7

Number key 8

Number key 9

Number key 0

Number key #

Press one after 
another 

 and 
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Hotkey assignment
You can call important functions/tests directly using the keys of the ARGUS keypad. 
Depending on the selected access type (xDSL and Ethernet in this example), different hot-
keys can be used:

Hotkey Service ADSL VDSL/
G.fast SHDSL ETH

Status screen x x x x

VoIP call x x x x

Press one after 
another 

 and 

Displays ARGUS-specific 
information such as ARGUS type, 
software version, serial number, 
own MAC address, software 
options, user information (see 
below)

x x x x
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Among other details, the ARGUS info displays the ARGUS type, the software version, the 
set software options and the serial number. 

When you select “Option”, you can enter the option Key.
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B) Symbols

The following symbols can be 
displayed in the ARGUS status 
line. 

Symbol Colour Purpose Description
Black Battery pack This symbol shows the current battery status.

Blue Cloud update The firmware can now be updated.

Grey Cloud update The update function is active but no update can be 
found. For example, due to an incorrect server path.

Blue Configuration 
import

A configuration file has been found.

Grey Configuration 
import

The configuration check is active but no configuration 
can be found. For example, due to an incorrect server 
path.

Grey Variable Importing a configuration or executing a test.

Green WLAN WLAN is active. ARGUS is now in access-point mode.

Grey WLAN WLAN is not active.

Grey Ethernet The management interface Ethernet is selected.

Green Ethernet The management interface Ethernet is active.

Black Volume Signal tone deactivated.

Black Volume Signal tone activated.
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The following symbols can 
appear in the ARGUS main 
display area.

Symbol Colour Description
Grey The service is not yet assigned to a virtual line.

Grey This service, VL or physical layer is idle.

Grey The service is unavailable.

Yellow Activating the physical layer, VL or service.

Yellow Physical layer, VL or service deactivated due to an unexpected occur-
rence.

Yellow Deactivating.

Green Synchronisation achieved (physical layer) or a VL or service was acti-
vated successfully.

Green A test is currently running in this service.

Red An error has occurred.

Grey Preparing activation of physical layer, VL or service.

Orange The Tx and Rx values are not equal in the VoIP QoS test.

Green Test running.
ARGUS 300 207



25 Appendix
Red Test stopped.

Green Graphs are zoomed.

White Graphs are not zoomed.

Green Cursor is activated.

White Cursor is deactivated.

The following symbols 
are displayed in this 
field. 

Symbol Colour Description
Green No CRC errors occurred in the last second.

Red No FEC errors occurred in the last second in upstream and down-
stream.

Green/ 
Red

No upstream CRC errors occurred in the last second in upstream.

Red/ 
Green

No FEC errors occurred in the last second in downstream.

Blue/
Grey

Retransmission configured but not active.

Blue Retransmission active.

Red Retransmission active; errors occurring.
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C) VoIP-SIP status codes

SIP requests:

The six basic requests/methods:

INVITE Invites the user to call (initiates session)

ACK Confirms an INVITE request

BYE Terminates the session

CANCEL Cancels the connection process

REGISTER Provides subscriber availability information (host name, IP address)

OPTIONS Provides information on supported functions of the SIP telephones involved in 
the call

SIP responses:

SIP responses follow on the SIP requests. There are six basic SIP response types with 
numerous variants.

1xx Provisional responses
(e.g. 180 shows ring at recipient) 

2xx Successful responses

3xx Redirect responses

4xx Client failure responses

5xx Server failure responses

6xx Global failure responses

ARGUS 
display: 
code no.

Meaning Explanation

100 Trying Trying to connect
180 Ringing The phone at the other end is ringing.
181 Call Being Forwarded The call is being forwarded.
182 Call Queued The call is in a wait loop.
183 Session Progress The call is being setup.
200 OK Everything is all right.
202 Accepted Connection has been accepted.
300 Multiple Choices There is no unique destination address for

the remote end. Please select one.
301 Moved Permanently The call is permanently forwarded.
302 Moved Temporarily The call is temporarily forwarded.
305 Use Proxy A proxy must be used.
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380 Alternative Service Alternative service.
400 Bad Request The request is not OK.
401 Unauthorized You are not authorized. 
402 Payment Required Payment is required. 
403 Forbidden This is not permitted. 
404 Not Found The remote end was not found or does not

exist.
405 Method Not Allowed Method (e.g. SUBSCRIBE or NOTIFY) is 

not allowed.
406 Not Acceptable The call’s options are not allowed.
407 Proxy Authentication Required The proxy must be authenticated.
408 Request Timeout The time for the request has been

exceeded (timeout).
409 Conflict There is a conflict. 
410 Gone The subscriber can no longer be reached.
411 Length Required The length must be supplied. 
413 Request Entity Too Large The values are too long. 
414 Request URI Too Long The URI is too long. (Destination address) 
415 Unsupported Media Type The codec is not supported. 
416 Unsupported URI Scheme The URI scheme is not supported. ? 

(Destination address) 
420 Bad Extension The extension is wrong.
421 Extension Required An extension is necessary.
423 Interval Too Brief There is a problem with the SIP

parameters.
(Register Expire is too short)

480 Temporarily Unavailable The subscriber is currently not reachable.
481 Call/Transaction Does Not Exist This connection does not exist (any longer).
482 Loop Detected A redirection loop has been detected.
483 Too Many Hops Too many redirects.
484 Address Incomplete The SIP address is incomplete or faulty.
485 Ambiguous The SIP address is ambiguous.
486 Busy Here Subscriber is busy.
487 Request Terminated The request has been terminated. 
488 Not Acceptable Here The call cannot be accepted. 
491 Request Pending A request is waiting.
493 Undecipherable Decryption error.
500 Server Internal Error Internal error in the server. 
501 Not Implemented The requested method (functionality) has 

not been implemented. 
502 Bad Gateway The gateway is bad. 
503 Service Unavailable The service is not available. 
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D) Vendor identification numbers

504 Server Time-Out The gateway did not respond in time. 
505 Version Not Supported The SIP protocol version is not supported. 
513 Message Too Large The message length is too long. Use TCP. 
600 Busy Everywhere All terminals are busy at the remote end. 
603 Declined The remote station declined the call.
604 Does Not Exist Anywhere The subscriber no longer exists.
605 Not Acceptable Impermissible SIP request.

Abbreviation Vendor
ALCB Alcatel (STMicroelectronics)
ANDV Analog Devices
BDCM Broadcom
GSPN Globespan
IKNS Ikanos
IFTN Infineon
META Metanoia
STMI STMicroelectronics
TSTS Texas Instruments
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E) Software licenses

The ARGUS firmware contains code from open-source packages published under a variety 
of licenses (GPL, LGPL, MIT, BSD, etc.). 
Additional information can be found on the internet at: http://www.argus.info/en/service/
downloads. After selecting your device type, you can download a PDF with the software 
licenses. 
If you are interested in the sources listed under GPL/LGPL, please contact 
support@argus.info. intec Gesellschaft für Informationstechnik mbH will provide you with a 
machine-readable copy of the source texts for a nominal fee to defray the costs of the 
physical copying process. This offer is valid for 3 years.
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F) Abbreviations
Characters

.bis Reference to SHDSL.bis (Enhanced SHDSL) 
2B1Q 2 binary 1 quaternary - line code 
3PTY Three party service
4B3T 4 binary 3 ternary - a modified monitored sum 43-code (MMS43) 

ΔC Absolute deviation between CaE and CbE

Δf Bandwidth 

ΔR Absolute deviation between Ra and Rb

Ω Ohm (electrical resistance) 
A

a a-wire (tip)
A Ampere (electrical current) 
A3K1H Audio 3,1 kHz
A7kHz Audio 7 kHz
AAL ATM adaptation layer
AC Alternating Current or Access Server
ACS Auto Configuration Server
ADSL Asymmetric Digital Subscriber Line
AFTR Address Family Transition Router
Al Action indicator
AIT Application information table
AMP ARGUS measurement protocol 
ANSI American National Standards Institute
Anx. Annex
AOC Advice of charge
AOC-D Advice of charge 

Charging information during the call 
AOC-E Advice of charge  

Charging information at the end of the call
APN Access Point Name
ARP Address Resolution Protocol
AS Available Second
ASCII American Standard Code for Information Interchange
ATM Asynchronous Transfer Mode
ATU-R ADSL Transceiver Unit - Remote
Auto-MDI-X Automatic Medium Dependent Interface Crossing
Avg Average

B
b b-wire (ring)
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BC Bearer capability
BER 1. Basic Encoding Rules

2. Bit error rate

BERT Bit error rate test
BGP Border Gateway Protocol
BNG Broadband Network Gateway
BR Bridge
BRAS Broadband access server
BRI Basic rate interface

C
C 1. Celsius

2. Capacitance
c0 Speed of light 
CALL PROC CALL PROCeeding Message
CAT Conditional access table
CC Continuity counter
CCBS Completion of calls to busy subscriber
CCNR Call complete no response
CD Call deflection
CDN see also CDPN
CDPN CalleD party number 
CF Call forwarding 
CFB Call forwarding busy
CFNR Call forwarding no reply
CFU Call forwarding unconditional
CGN see also CDPN
CGPN CallinG party number
CLIP 1.Calling Line Identification Presentation  

2. Clipping
CLIR Calling Line Identification Restriction
Cm Operating capacitance (mutual capacitance)
CNS CLIP-no screening
CO Central office
Codec Coder decoder
COLP Connected Line Identification Presentation
COLR Connected Line Identification Restriction

CONN CONNect Message
CONN ACK CONNect ACKnowledge message
Cp Parallel Capacitance
CQE Conversational Quality Estimated
CR Call reference
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CRC Cyclic redundancy check
Csym Capacitive symmetry
CT Call transfer
CUG Closed user group
CW Call waiting

D
dB Decibel
dBm/Hz Performance measurement with the reference quantity 1 mW (milliwatt) 

per hertz
DC Direct Current
DCE Data communication equipment
DDI Direct dialling in
DDM Digital diagnostic mode
DF Delay factor
DHCP Dynamic Host Configuration Protocol
diffserv Differentiated services
DIN Deutsches Institut für Normung - German Institute for Standardization 
DISC DISConnect message
DL Download
DMT Discrete Multitone Transmission
DNS Domain Name System
DPBO Downstream power backoff
DS Downstreamband
DSCP Differentiated services codepoint
DSL Digital Subscriber Line
DSLAM Digital Subscriber Line Access Multiplexer
DSS1 Digital Subscriber Signalling System No. 1
DTE Data Terminal Equipment 
DTMF Dual Tone Multi Frequency
DTU Data Transmission Unit

E
E1 Primary Rate Interface 
EARFCN EUTRA Absolute radio-frequency channel number
EC European Community 
ECT Explicit Call Transfer
E-DSS1 European Digital Subscriber Signalling System Number 1
EFM Ethernet in the First Mile (Protokoll see IEEE 802.3ah)
EFS Error Free Seconds
EIT Event Information Table
ElektroG Elektro- und Elektronikgerätegesetz, German law governing electrical 

and electronic devices
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EMC Electromagnetic compatibility 
EN European standard
EoA Ethernet over ATM
EOC Embedded operations channel
ES Errored seconds
ESHDSL Enhanced SHDSL (SHDSL.bis)
ete end-to-end
ETH Ethernet
ETR Expected Throughput Rate
ETSI European Telecommunications Standards Institute

F
F Farad (unit of electrical capacitance) 
Fax G3 Telefax group 3
Fax G4 Telefax group 4
FEC Forward error correction
FFT Fast Fourier transform
FSK Frequency shift keying
FTP File Transfer Protocol
FW Firmware

G
G.fast G.fast access to subscriber terminal
GB Gigabyte
Gbit/s Gigabits per second
GCID Global Cell ID
G.hs ITU-T G.994.1 Handshake procedure
GigE Gigabit Ethernet
GND Ground (earth)

H
h hour
HD High definition
HDLC High-level data link control
HDSL High bit rate digital subscriber line
HEC Header error checksum
hex Hexadecimal
HLC High layer compatibility
HLOG Amplitude of transmission function per tone 
HOLD Call hold
HRX-Wert Hypothetical reference value
HTTP Hypertext Transfer Protocol
Hz Hertz (measuring unit of frequency)
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I
I Electric current
IAD Integrated access device
ID Identifier
IDC DC Current
IEEE Institute of Electrical and Electronics Engineers
IGMP Internet Group Management Protocol
INFO INFOrmation Message
INP Impulse noise protection
IP Internet Protocol
IPCP Internet Protocol Control Protocol
IPoA Internet Protocol over ATM
IPoE Internet Protocol over Ethernet
IPTV Internet Protocol Television
ISO International Standards Organization 
Iso. Isolation resistance measurement
ISP Internet service provider
ITSP Internet telephony service provider 
ITC Independent TC
ITU International Telecommunication Union

K
KB Kilobyte
kbit/s Kilobits per second 

L
L1 Layer 1 in the OSI reference model 
L2 Layer 2 in the OSI reference model 
L3 Layer 3 in the OSI reference model 
LACP Link Aggregation Control Protocol
LAN Local Area Network
LAPD Link access procedure for D-channels 
LCD Liquid crystal display
LCL Longitudinal Conversion Loss
LCN Logical channel number
LCP Link Control Protocol
LED Light-emitting diode 
LLC Low layer compatibility
LLDP Link Layer Discovery Protocol
LOS Loss of synchronize
LOSWS Loss of sync word seconds
LQ Line qualification 
LQO Listening quality objective
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LTE Long Term Evolution
M

m Meter
MAC Media Access Control
MB Megabyte
Mbit/s Megabits per second
MCC Mobile Country Code
MCID Malicious call identification
MDF Main Distribution Frame
MDI Media Delivery Index (RFC 4445)
MLR Media loss rate
MMS Microsoft Media Server Protocol
MNC Mobile Network Code
min. Minute
Modem Modulator-demodulator
MOS Mean opinion score (ITU-T P.800)
MPEG Moving Picture Experts Group
MSA Multiple source agreement
MSN Multiple Subscriber Number
MTU Maximum Transmission Unit
mVpp Millivolt peak-to-peak 

N
n/a not available
n/r not received
n/u not used
NAT Network address translation
NEXT Near-end crosstalk
NGN Next generation network
NIT Network information table
NOK Not OK
NP Numbering plan
NSAP Network service access point
NSF Network specific facilities
NT Network termination
NTR Network timing reference

O
OAM Operation, Administration and Maintenance
OM Omni Mode
OoS Out of Sequence
OSI Open Systems Interconnection
OUI Organizationally unique identifier
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P
P/N Part number 
PABX Private automatic branch exchange
PADI PPPoE active discovery initiation
PADO PPPoE active discovery offer
PADR PPPoE active discovery request
PADS PPPoE active discovery session confirmation
PADT PPPoE active discovery termination
PAM Pulse amplitude modulation 
PAP Password Authentication Protocol
PAT Program association table
PC Personal computer
PCR Program clock reference
PD Protocol discriminator
PDU Protocol data unit
PEN Private Enterprise Number
PID Packet identifier
PIN Personal Identification Number
PLR Packet loss ratio
PMT Program map tables
Pol. Polarity
POTS Plain old telephone service (PSTN)
P-P Point-to-point 
P-MP Point-to-multipoint 
PMMS Power measurement modulation session
PMS Physical media specific
PPP Point-to-Point Protocol
PPPoA Point-to-Point Protocol over ATM
PPPoE Point-to-Point Protocol over Ethernet
PPTP Point-to-Point Tunneling Protocol
PSD Power spectral density
PSI Program specific information
PWR Power

Q
Q in Q IEEE 802.1.ad, S-VLAN
QLN Quiet line noise
QoS Quality of service

R
R 1. Resistance (electrical resistance)

2. Ring (b-wire)
Ra Resistance a-wire
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Rb Resistance b-wire
RE Ground resistance
RC Resistance (R) and capacitance (C) 
REIN Repetitive electrical impulse noise
REL RELease message
REL ACK RELease ACKnowledge message
REL COMPL RELease COMPLete message
Rem. Remote (instrument kit control)
RF Radio frequency
RFC Request for comments
Ri Internal resistance
Ring b-wire
RJ Registered jack (standardised socket) 
RoHS Restriction of hazardous substances
Rs Loop resistance
Rsym Resistance symmetry
RT Router
RTCP Real-Time Control Protocol
RTP Real-Time Transport Protocol
RTSP Real-Time Streaming Protocol
Rx Received

S
s second
S/N Serial number
SBC Session Border Controller - Outbound Proxy
SCI Sending complete indication
SDT Service description table
Segm. Segmented
SES Severely errored second
SFF Small form factor
SFP Small form factor pluggable
SHDSL Single-Pair High-speed Digital Subscriber Line
SHINE Single high impulse noise event
Sig. Signatures
SIM Subscriber Identity Module
SINR Signal-to-interference-plus-noise ratio
SIP Session Initiation Protocol
SNR Signal-to-noise ratio
SNRM Signal-to-noise ratio margin
SPB Shortest Path Bridging
Spch Speech (dt. Sprache)
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SRU SHDSL regeneration unit
SRV Service record
SSL Secure Sockets Layer
STB Set-top box
STU-C SHDSL Transceiver Unit - Central Office
STU-R SHDSL Transceiver Unit - Remote
STUN Session Traversal Utilities for NAT
SUB Subaddressing
SUSP SUSPend message
Sym Symmetry

T
T 1. Tip (a-wire)

2. Trigger
TAC Type Approval Code
TC 1. Trellis code 

2. Transmission convergence
TCP Transmission Control Protocol
TC-PAM Trellis-coded pulse amplitude modulation 
TDM Time division multiplex
TDR Time domain reflectometry
TDT Time and date table
TE TErminal, terminal equipment
TEI Terminal endpoint identifier
Tel31 Telephony 3.1 kHz 
Tel7k Telephony 7 kHz
TLS Transport Layer Security
TM Test manager
ToN Type of Number
ToS Type of service
TP Terminal portability
TPID Tag Protocol Identifier
TRG Tip, Ring, Ground
TS 1. Technical specification 

2. Transport stream
TTX Teletext
Tx Transceived

U
U Voltage
UAC AC Voltage
UDC DC Voltage
UDP User Datagram Protocol
ARGUS 300 221
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UL Upload
URI Uniform Resource Identifier
URL Uniform Resource Locator
US VDSL: Upstream band or  

SHDSL: Unavailable second
USB Universal Serial Bus
UTC Coordinated Universal Time
UUI User-user info
UUS User-to-user signalling

V
V Volt 
V/2 Pulse propagation time 
VC Virtual channel
VCC 1. Virtual channel connection 

2. Voltage at the common collector
VCI Virtual channel identifier
VC-MUX Virtual circuit multiplexing
VDSL Very High Speed Digital Subscriber Line
ViSyB Video syntax-based
ViTel Video telephony
VLAN Virtual Local Area Network
VL Virtual line
VLC Video LAN client
VNC Virtual Network Computing
VoD Video on demand
VoIP Voice over Internet Protocol
VoP Velocity of propagation
VPI Virtual path identifier
Vpp Volt peak-to-peak
VTU-R VDSL Transceiver Unit - Remote

W
WebDAV Web-based Distributed Authoring and Versioning
WEEE Waste Electrical and Electronic Equipment
www World Wide Web

X
xDSL Collective term for the different DSL variants
xTU-C xDSL Transceiver Unit - Central Office
xTU-R xDSL Transceiver Unit - Remote

Z
Z Apparent resistance 
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